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FX Tools Software Package – 
FX Builder User’s Guide 

Introduction 
FX Builder is part of the FX Tool Pro software package. Use 
FX Builder to create applications for the Facility Explorer Series of 
Heating, Ventilating, Air Conditioning, and Refrigeration (HVACR) 
controllers. FX Builder provides a graphical programming 
environment and features that help you generate programs quickly and 
accurately. 

FX Builder includes a set of standard function blocks and control 
objects that you can use independently or nested in custom assemblies 
that you can reuse in other applications. FX Builder not only offers 
complete flexibility in the generation of applications but also includes 
features to save and reuse applications as standards where appropriate. 
See 139HFigure 1X. 

FX Builder provides you with all the tools you need to: 

• define and configure the target device and its physical inputs 
and outputs 

• engineer the control algorithm 

• identify the data points to be monitored and the format of the 
user interface 

• enable and configure trends, schedules, and events 

• configure the Short Message Service (SMS) or e-mail 
messaging services for monitoring data and events from remote 
locations 

• design Web pages for the embedded Web server 

• define the network profile for N2, LONWORKS®, or BACnet® 
protocols 
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Figure 1: FX Builder 
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Installation 

Installing FX Builder 
Microsoft® Windows® Operating System (OS) Upgrade 

FX Builder includes a simulator plug-in based on the Microsoft .NET 
Framework; therefore, you need to install Microsoft .NET Framework 
Version 2.0 to run FX Builder. 

Upgrade the Windows OS on your computer before proceeding with 
this installation. 

The .NET Framework 2.0 
The .NET Framework is a component of the Windows operating 
system used to build and run Windows OS based applications. 

Checking the .NET Framework Installation 
To check the .NET Framework installation: 

1. From the Start menu, go to the Control Panel. 

2. Double-click Add or Remove Programs. The Add or Remove 
Programs window appears. 

3. Scroll down the list of applications. If Microsoft .NET Framework 
2.0 appears, then the Windows OS upgrade is not necessary. 

Getting Microsoft .NET Framework 2.0 
To get Microsoft .NET Framework 2.0, go to the FX Tools Pro CD. 
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Installing FX Builder 
To install FX Builder: 

1. Close all open programs. 

2. Insert the FX Tools Pro CD-ROM into the CD-ROM drive. The 
FX Tools Pro software menu appears (X140HFigure 2X). 

Note: If the FX Tools Pro software menu does not appear, select 
Autorun.exe to start it manually. 

 
Figure 2: FX Tools Pro Software Menu 

3. From the software menu, click FX Builder. The File 
Download-Security Warning window appears (X141HFigure 3X) and 
prompts you to run or save the file. 

4. Click Run. 

 
Figure 3: File Download - Security Warning 

Note: If .NET Framework is not installed, an error message 
appears (X142HFigure 4X) and the installation process ends. 
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Figure 4: NET Framework Not Installed Error 
Note: If this Security Warning appears, click Run to continue 
the installation (X143HFigure 5X). 

 
Figure 5: Security Warning 

 
Figure 6: FX Builder InstallShield® Wizard 

5. Click Next (X144HFigure 6X). The Destination Folder window appears 
( X145HFigure 7X). 
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Figure 7: Destination Location 

Note: To install the program in a directory other than the default 
directory shown in the Destination Folder box, click Browse and select 
a different directory. 

6. Click Next. The Select Program Folder window appears (X146HFigure 8X). 

 
Figure 8: Select Program Folder 

7. Click Next. The Setup Status and NodeBuilder Resource Editor 
windows appear (X147HFigure 9 X and X148HFigure 10X). When FX Builder 
installation finishes, the Installation Complete window appears 
( X149HFigure 11X). 
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Figure 9: Setup Status 

 
Figure 10: NodeBuilder Resource Editor 

 
Figure 11: Installation Complete 

8. Click Finish. 

Note: Do not rename the program directory after you install the 
program. 
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Installing FX Simulator 
Once the FX Builder installation finishes, you need to install 
FX Simulator. 

To install FX Simulator: 

1. Close all open programs. 

2. Insert the FX Tools Pro CD-ROM into the CD-ROM drive. The 
FX Tools Pro software menu appears. 

Note: If the FX Tools Pro software menu does not appear, select 
Autorun.exe to start it manually. 

3. From the software menu, click FX Simulator. The File Download - 
Security Warning window appears (X150HFigure 12X) and prompts you to 
run or save the file. 

4. Click Run. The FX Simulator Setup Wizard appears (X151HFigure 14 X). 

 
Figure 12: File Download-Security Warning 

Note: If this Security Warning appears, click Run to continue 
the installation (X152HFigure 13 X). 

 

Figure 13: Security Warning 
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Figure 14: FX Simulator Setup Wizard 

5. Click Next. The Confirm Installation window appears  
( X153HFigure 15X). 

 
Figure 15: Confirm Installation 

6. Click Next. The Installing FX Simulator status window appears 
( X154HFigure 16X). 
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Figure 16: Installing FX Simulator Status Window 

When the FX Simulator installation finishes, the FX Simulator 
Information window appears (X155HFigure 17X). 

 
Figure 17: FX Simulator Information Window 

7. Click Next. The Installation Complete window appears  
( X156HFigure 18X). 
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Figure 18: Installation Complete 

8. Click Close and exit the software menu. 
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Installing the Make Public Key 
Note: The Make Public Key is automatically installed from 
FX Builder 5.x. See X157HFX Builder SecurityX for more information about 
the security provided by the Customer ID feature. 

Installing the Demo Version Key 
Note: The Demo Version customer ID is typically used for FX devices 
fitted to demonstration and simulation cases.  

To install the Make Demo Key: 

9. Close FX Builder. 

10. On the FX Tools Pro CD-ROM, locate the file in 
...\Software\Make Demo Key and double-click on  
DemoVersionInstaller.exe. 

 
Figure 19: Make Demo ID Registration 

11. Click OK ( X158HFigure 19X) and then click Yes to register the key. 

12. Open FX Builder and select Save and Export as to view the 
Select the Customer ID window ( X159HFigure 20X). You can now save 
demo applications. 

 
Figure 20: Save Demo Application 
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FX Builder Navigation 

FX Builder Entry Screen 
The FX Builder entry screen (X160HFigure 21X) includes a main menu of 
commands allowing you to: 

• create a standard application using an application wizard 

• create a new application using a programming approach 

• open an existing application 

• change the units of measure 

• adjust application wizard preferences 

• determine the version of FX Builder 

  
Figure 21: FX Builder Entry Screen 

The File menu allows 
you to create a new 
application, launch the 
application wizard, or 
open an existing 
application. 

The Help menu allows you to 
determine the version of FX Builder. 

The Settings menu allows you to select the units of 
measure SI (°C) or US (°F) displayed in the FX builder 
application programming environment, and set the 
Application Wizard Preferences. 
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Main Screen 
FX Builder includes a single Integrated Development Environment 
(IDE) to program the application algorithm, simulate the application, 
and configure services for the application. 

  
Figure 22: FX Builder Main Screen 

On the FX Builder main screen (X161HFigure 22X), there are five sections: 

• Menu Bar and Toolbar - offer an interface to the available 
actions allowed on the selected item. 

• Application Objects Tree - shows the objects included in the 
application. 

• Details View - shows the device and application name, address, 
number of objects, and available memory related to the selected 
element in the Control View canvas. 

• Network View - lists the devices associated with the 
application. 

• Control View Canvas - shows the application algorithm in a 
graphical way on the different application levels (devices, 
application, macros, and objects). 

Details View 

Network View 

Control View Canvas 

Menu Bar

Application Objects Tree 

Toolbar 
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Menu Bar 
File Menu 
The File menu provides the following options: 

• New Application - creates a new application using a 
programming approach. 

• Application Wizard – creates a standard application using a 
wizard approach. 

• Open - opens an existing application. 

• Save - saves the current application. 

• Save As - saves the current application under another name. 

• Save Diagram As - extracts the application architecture as an 
Enhanced MetaFile for Windows OS (.emf). 

• Print Preview - previews the printout of the application 
architecture. 

• Print - prints the application architecture. 

View Menu 
The View menu provides options to change the way the application 
appears on the computer screen. The View menu has the following 
options: 

• Application Object Tree - shows or hides the Application 
Objects Tree. 

• Network - shows or hides the Network window. 

• Details - shows or hides the Details window. 

• Grid - shows or hides canvas grid lines. 

• Zoom - zooms in or out of the application architecture. 

Settings Menu 
• Unit of Measure - allows you to select the units of measure 

used to present data points on the screen. You can set the units 
of measure to either SI (°C) or US (°F). 

• Application Wizard Preferences – allows you to select 
documentation to be generated and the file location where 
documentation is to be exported, install standard application 
packages, and view application package information. 
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Application Menu 
The Application menu provides links to application-related plug-ins 
including: 

• Application Points - allow you to view and edit application 
point details such as point name, data type, state names, units of 
measure, and default point values. The application point plug-in 
also allows you to assign events and trends to points. 

• Trends - allows you to configure the trend sample time, 
start/stop conditions, and notification services. 

• Events - allows you to configure event notification services. 

• Address Book - allows you to define the contact information 
used by the controller for its notification services. 

• Web Site - allows you to design the layout of the Web pages. 

• Notification Services - allows you to configure the e-mail, 
SMS, and Web page service parameters. 

• Hardware Parameters - allows you to configure the RS-232 
and modem parameters. 

The Application menu also provides links to: 

• Check Mandatory Inputs - identifies any missing mandatory 
connections. 

• Check Consistency - determines if the application falls within 
the memory and performance limits of the targeted device. 

• Show Documentation - allows you to create a Microsoft Word 
document showing the application architecture. 
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Device Menu 
The Device menu provides links to the following functions: 

• Edit Control Logic - opens the Application Editor for the 
currently selected device. 

• Simulate Control Logic - opens the FX Simulator for the 
currently selected device application. 

• Save Control Logic - allows you to save an Application 
Assembly for future use. 

• Add Display - allows you to build and configure a display 
module. 

• Add Slave - allows you to create a new slave device or add a 
slave device from an existing application. 

• Device Info - allows you to view and edit additional 
information related to the current Application Assembly 
associated with the device. 

• Wiring Diagram - allows you to print out a Word document 
showing the target controller and the input/output channel 
assignments. 

Protocol Menu 
The Protocol menu provides plug-ins to create and edit the specific 
network profile associated to the application. 

• N2 Open - opens the N2 Open plug-in to create and edit the N2 
Open network profile. 

The N2 Open plug-in allows you to determine which application 
points are included in the N2 network profile, define the N2 short 
and long names, change the N2 point type and address, and print 
out the .prn file. 

• LON - opens the LON plug-in to create and edit the LON 
network profile. 

The LON plug-in allows you to determine which application points 
to include in the LON network profile, define the LON variable 
name, change the Program ID, and generate the LON resource 
files. 

• BACnet - opens the BACnet plug-in to create and edit the 
BACnet network profile. 

The BACnet plug-in allows you to determine which application 
points to include in the BACnet network profile, and define the 
BACnet object names and other configuration properties. 
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Help Menu 
The Help menu provides information about FX Builder, including the 
installed version number. 

Toolbar 
The Toolbar provides an interface to the commands that are available 
for the selected item (See X162HFigure 23X and X163HTable 1X). 

 
Figure 23: FX Builder Toolbar 

Table 1: FX Toolbar Icons  
Icon Description 

 
Create application 

 
Create an application from an existing template 

 
Open an existing application 

 
Save current application 

 
Print diagram 

 
View diagram print preview 

 
Show or hide the grid 

 Zoom 

 
Application points plug-in 

 
Trend plug-in 

 
Event plug-in 

 
Address book plug-in 

 
Web site plug-in 

 
N2 Open plug-in 

 
LON plug-in 

 
BACnet plug-in 
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Application Editor 
The FX Builder Application Editor users layered screens to 
graphically represent the application programming structure. 

 
Figure 24: FX Builder Application Editor 

The FX Builder Application Editor (X164HFigure 24X) contains six sections: 

• Menu Bar and Tools Bars - offer an interface to the available 
actions allowed for the selected item. 

• Assembly Summary - shows the objects included in the current 
assembly. 

• Object Execution Order - shows the objects in the currently 
assembly listed in order of execution. 

• Details View - shows the current target device, number of 
objects, and available memory. 

• Network View - lists the devices associated to the application. 

• Graphic Canvas - shows the application algorithm in a 
graphical representation on the different application levels 
(devices, application, macros, and objects). 

Assembly  
Summary 

Objects Execution 
Order View 

Details View 

Toolbar 

Menu Bar 

Objects Basket 

Graphic Canvas 
(the layout/grid area) 
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• Objects Basket - a library of objects used to create the 
application algorithms. Open the Objects Basket from the View 
menu. 

Menu Bar 
File Menu 

The File menu provides the following options: 

• Page Setup - allows you to set page formats. 

• Print Preview - previews the printout of the application 
architecture. 

• Print - prints the application architecture. 

• Exit - closes the application editor. 

Graphic Menu 
The Graphic menu provides the following options: 

• New Label - allows you to apply a new label to a diagram. 

• Save diagram as EMF - allows you to save a diagram as an 
Enhanced Metafile. 

View Menu 

The View menu provides options to change the way the application 
appears on the computer screen. 

• Assembly Summary - shows or hides the Assembly Summary 
window. 

• Details - shows or hides the Details window. 

• Objects Basket - shows or hides the Objects Basket. 

• IOM Object Basket - shows or hides the IOM Object Basket. 

• Grid - shows or hides the Grid. 

Assembly Menu 
The Assembly menu provides options for creating and editing 
assembly attributes and data. 

• New - creates a new assembly. 

• Load - loads an existing assembly. 

• Rename - enters a new macro name for the selected assembly. 

• Edit Info - edits the selected assembly Prepared By and 
Description information. 

• All Attributes - shows or hides attributes of the selected 
assembly. 
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• Build Interface - builds input, output, attribute, parent, and 
child interfaces. 

• Details and Dimensions - updates the Details window. 

Objects Menu 
The Objects menu provides options for creating and editing object 
attributes and data. 

• Rename - allows you to rename the selected object. 

• Remove - allows you to remove the selected object. 

• Launch Plug In - launches a plug-in for the selected object. 

• View Data Sheet - opens the datasheet for the selected object. 

• Show Attributes - shows attributes for the selected object. 

• Launch Simulator - launches a simulator for the selected 
object. 

Connections Menu 
The Connections menu provides a means to check the mandatory 
connections. 

• Check Mandatory - checks all mandatory connections. 

? Menu 
The Help menu provides options for viewing the online help and the 
version. 

• Help - displays the online help for FX Builder. 

• About - displays version information for Assembly generator. 
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Toolbar 
The Toolbar provides an interface to the commands that are available 
for the selected item (See 165HFigure 25X and X166HTable 2X). 

 
Figure 25: FX Builder Application Editor Toolbar 

Table 2: FX Builder Application Editor Toolbar Icons  
Icon Description 

 
Print the diagram 

 
Print Preview 

 
Insert a New Label 

 
Show Object basket 

 
Show IOM Object Basket 

 
Launch Plug-in of the selected object 

 
Remove the selected object 

 
Check Mandatory Connections 

 
Add Continuations 

 
Show or Hide the Grid 

 
Zoom 

 
Insert Input 

 
Insert Output 

 
Insert Attribute 

 
Insert Continuation Parent 

 
Insert Continuation Child 
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Creating and Editing an 
Application 

FX Builder Key Topics 
Use FX Builder to program and configure the Facility Explorer series 
of HVACR controllers. You build the application on a graphical 
canvas by creating and connecting instances of the available objects in 
the object database of the controller. 

Application Object 
An application object is a functional block representing some 
interaction points called Input References and Output References. 
You can use the input/output references, via connections, to share 
values between objects. A connection always has the same direction 
(from a source to a target). Application objects also have Attributes, 
which are static values that you set only at design time. You typically 
use attributes to configure the behavior performed by the object or as 
backup values in case the output values are missing or invalid. 

In the Facility Explorer Series of HVACR controllers, the control 
algorithm can also interact with various available plug-ins. For 
example, the logic can generate an event/alarm condition that requires 
an SMS text message notification to be sent. 

There are over 80 different configurable application objects 
(depending on the target controller) to create the application algorithm. 

Application Algorithm 
The application algorithm is the function performed by a controller. 
Each device executes its own control algorithm depending on the 
configuration loaded. You create the application algorithm by 
selecting instances of the available application objects, configuring 
them, and then connecting them. 

Macro/Assembly 
A macro/assembly represents a group of application objects connected 
in subsets called Assemblies. You can isolate assemblies within a 
larger application, or you can export and save the assemblies as  
stand-alone files (.mcr). Assemblies allow you to reuse frequently used 
control sequences, reducing engineering time. 
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Application Profile 
The application profile represents the interface between the device and 
the application points. Each device has its own application profile. 

Network Profile 
The network profile represents the interface between the application 
points and the network. The Protocol plug-in allows you to define how 
the desired application points are exposed to the N2, LONWORKS, or 
BACnet supervisory system. 

Plug-in 
A plug-in is an add-on piece of software that enhances and extends 
another application. The plug-in is typically used to configure an 
application with easy to use and intuitive data entry screens. 

Application Types 
FX Builder allows you to develop three types of applications. See 
X167HTable 3X. 

Table 3: FX Toolbar Icons 
Application Description 
Stand-Alone 
Applications 

FX05 Advanced, FX06, FX07, FX14, FX15, FX16, 
and FX10 Advanced 

Distributed Applications FX16 Master Controller or the MD20 Master Display 
can act as the master controller (maximum 16 slave 
devices in FX16 and maximum 8 slave devices in an 
MD20). 

Network Applications FX16 Master Controller or the MD20 Master Display 
supervises and monitors a network of N2 Open and 
N2 System 91 devices. 

 

Stand-Alone Application 
A stand-alone application is a control strategy that runs in a single 
controller as an independent entity. If necessary, you can establish a 
network communication to let the stand-alone application be 
monitored by a supervisory system (N2 Open, LON, or BACnet). 

Stand-alone applications are used to control independent devices such 
as air handling units or zone temperature control equipment. 

Distributed Application 
A distributed application is a control strategy involving multiple 
controllers operating together to form a single control system. 
Distributed applications require the MD20 Master Display or the 
FX16 Master Controller (each hereafter referred to as master device) 
to manage the activities of the entire control system. A distributed 
application is executed concurrently in the master device and in up to 
16 Facility Explorer field controllers connected to the Local Link Bus. 
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Note: The FX16 supports 16 slave controllers whereas the 
MD20 Master Display supports 8 slave controllers in a distributed 
application. 

The communication between the master device and slave controllers is 
defined by network variables in the distributed application. The master 
device executes the communication in the most effective way to 
maintain the performance of the entire control system. 

You use distributed applications for the coordinated control of a 
central plant and the remote equipment it serves. For example, you can 
apply a distributed application to an FX16 controlling an air handling 
unit and a number of FX07 controllers controlling zone terminal units. 
The distributed application can also combine FX Controllers to 
provide required inputs and outputs for the physical equipment 
interface. The distributed application is then automatically distributed 
and executed in the individual controllers as a single control system. 
Each slave device works independently and provides its own 
information to the network through the application profile. The master 
device handles polling, refreshing, or forcing the network variables 
within the slave systems to synchronize the entire distributed 
application for proper operation. 

The distributed application (.apd extension) is downloaded directly 
into the target MD20 Master Display or the FX16 Master Controller; 
then the relevant parts are subsequently downloaded by the controller 
into the connected slaves at first powerup. 
The slave devices must have the N2 Open communication card 
installed. The connectable slave controllers are as follows: 

• FX05 (Advanced) Field Controller 
• FX06 Field Controller 
• FX07 Field Controller 
• FX10 (Advanced) Original Equipment Manufacturer (OEM) 

Controller 
• FX14 Field Controller 
• FX15 Field Controller 
• FX15 Universal Field Controller 
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Figure 26: FX16 Master Controller Performing a Distributed Application 

Before you connect the slave devices to the MD20 Master Display or 
the FX16 Master Controller, you need to set the devices with the 
correct address (that is, the address reserved for them in the application 
at design time). See X168HFigure 26X. 

Network Application 
A network application is a control strategy managed by a master 
device supervising a network of N2 Open and N2 System 91 
controllers connected to its Local Link Bus. 

The communication between the master controller and the controllers 
on the network is defined in the Gateway objects in the application of 
the master controller. 

A network application in the MD20 Master Display is the ideal 
solution to monitor and control a small commercial HVAC plant, a 
refrigeration plant, or a number of devices in a small building. The 
MD20 can also be used to monitor a zone of a larger building to 
provide an overview of the operation from one location. 

A network application in the FX16 Master Controller allows you to 
integrate N2 devices (such as variable speed drives) into the control 
strategy in the master controller. You can also run a distributed 
application with slave FX controllers. 

You can use the master device and its network application as a system 
integrator of various control devices and networks or as a 
communication gateway into a small building from other buildings or 
remote operating centers. 

Each slave device in a network application provides information to the 
master device through its N2 Open communication interface. See 
X169HFigure 27X. 

See X170HConfiguring the Gateway ObjectX for more information.  
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Figure 27: MD20 Master Display Supervising an N2 Network 

Generated Application and Documentation Files 
The Application Wizard generates Application and documentation 
files. The type of files generated depends on the selections made in the 
Application Wizard Preferences dialog box (171HFigure 29) and 
Configuration Options plug-ins (172HFigure 36). See 173HCreating a Standard 
Application Using the Application Wizard. 

• .apd - the application file that gets downloaded to the controller 

• .prn - N2 Print File (only if N2 was selected) 

• .txt - application header data 

• *appname*HdwCfg.doc - the Hardware Configuration Document 
(describes the input/output wiring assignments) 

• *appname*N2OpenProfile.doc - the Network Profile Document 
(very similar to the .prn file except in a Word document format) if 
N2 was selected. Or *appname*LONProfile.doc if LON was 
selected, and *appname*BACnetProfile.doc if BACnet was 
selected. 

• *appname*AppCfg.doc - the Application Configuration 
Document, which lists all the configuration options and settings the 
user selected during the configuration session. 

• *appname*.xif | .enu | .ftp | .typ | .fmt - are the LON resource 
files (if LON network was selected) 

Note: No specific BACnet resource files are exported (BACnet 
does not require resource files). 

MUI Display 
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FX Builder Detailed Procedures 
There are two methods for creating a new application. 

• Application Wizard Approach: creates a standardized 
application based on the selected system and device 
pre-programmed options. See X174HCreating a Standard Application 
using the Application WizardX. 

• Programming Approach: creates a customized application based 
on system and device programming. See 175HCreating an Application 
(Programming Approach)XX.  

Creating a Standard Application (Application Wizard Approach) 
The Application Wizard contains the following features: 

• intuitive menu selection and graphic configuration environment to 
create applications 

• configuration procedures, which do not require programming 
skills, to make configuration easier 

• a library of validated and proven standard applications to decrease 
the engineering, testing, and validation time 

• inapplicable configuration options, which are disabled and are 
red-flagged, to prevent the user from making improper application 
choices 

• plug-ins to configure commonly used features of the standard 
applications 

• summary tabs to provide information about the selections made 
during the configuration session 

Creating a Standard Application Using the Application 
Wizard  
To create a standard application using the Application Wizard:  

1. Obtain and install the Application Packages. 

2. Select a standard Application. 

3. Select the configuration values for the plug-ins for the selected 
application. 

4. Adjust the Exception Day and Occupancy calendars. 

5. View the configuration summary report and I/O assignments. 

6. Select the user interfaces, network protocol, and target devices. 

7. Configure the hardware I/Os. 

8. Generate the Application files and documents. 

9. Export the application (.apd and commissioning files). 
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Installing the Application Packages 
FX Application Packages are obtained individually and then saved to a 
folder on the computer where FX Builder is installed. 

To install the application packages: 

1. Obtain the desired Application Packages and save them to the 
TemplateApplications folder. 

2. Launch FX Builder. 

3. Click Settings > Application Wizard Preferences (X176HFigure 28X). 

 

Figure 28: Settings > Application Wizard Preferences Menu 
The Application Wizard Preferences dialog box appears 
( X177HFigure 29X). 

 

Figure 29: Application Wizard Preferences Dialog Box without 
Packages Installed 
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4. Under File Preferences, select the documents you want to generate. 
If desired, change the File Location to where the generated files are 
exported. 

5. Click Install… and navigate to C:\ > Program Files > JCI > 
FX Builder > TemplateApplications. 

6. Select the desired Application Package (.dbe file) and click Open 
( X178HFigure 30X). 

 

Figure 30: Select Package Dialog Box 
The Application Package is installed in the Application Wizard 
Preferences dialog box ( X179HFigure 31X). Repeat step X180H5X and step X181H6X for each 
Application Package you wish to install. 

 

Figure 31: Application Wizard Preferences Dialog Box with Packages 
Installed 

7. Click Ok to exit the Application Wizard Preferences dialog box. 
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Selecting a Standard Application 
Standard applications are typically classified based on the following 
criteria: Air Handlers, Terminal Units, Central Plants, and Rooftop 
Units. 

To select a standard application: 

1. Open FX Builder. 

2. Click File > Application Wizard ( X182HFigure 32X). The Select an 
Application Template Window appears (X183HFigure 33). 

 

Figure 32: File > Application Wizard Menu 

 
Figure 33: Select an Application Template Window 

3. On the left side of the window, select the application category 
(for example, Air Handlers, Terminal Units, Central Plants, or 
Rooftop Units). 
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4. Select the desired application within the application category. The 
Template Information on the right side of the Select an Application 
Template Window ( X184HFigure 33X) is populated with: 

• the Revision number  

• a Prepared by label 

• a Description of the application 

• a Show Documentation button that launches the Application 
Notes document for the selected application 

• a visual representation of the application 

5. Click Next. A status bar appears while the selected application and 
plug-ins are loaded into FX Builder (X185HFigure 34). 

 

Figure 34: Loading Application Status Bar 
The Configure plug-in appears when the application is loaded  
( 186HFigure 35).  
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Working with Plug-ins  
Plug-ins contain categories, functions, and values ( 187HFigure 35). When 
you select a category, the relevant functions and values appear. Use 
these tips when working with functions and values. 

• Some functions and values are dependent on previous selections. 
Work from the top of the list to the bottom of the list. 

• If the function/value appears dimmed, it is not available. If you 
require that function, try changing some configuration options 
above. 

• Double-click in the function field to cycle through the different 
values. 

• Click in the value field to activate a drop-down arrow. Click the 
drop-down arrow to display a menu and select the desired value. 

 

 

Figure 35: Application Wizard Plug-ins  

Category Function  Value 
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Selecting Configuration Options 
The Configuration plug-in contains all the adjustable control logic 
functions within the selected application. 

To select configuration options: 

1. Click Configuration. The Configuration categories and values 
appear (X188HFigure 36X). 

 
Figure 36: Configuration Plug-in 

2. Modify the configuration settings as needed. 
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Adjusting NRM Config 
The NRM Config plug-in contains all adjustable NRM setpoints 
within the selected application. The NRM Config plug-in appears only 
when supported by the selected application.  

To adjust NRM Config: 

1. Click NRM Config. The NRM Config functions and values appear 
( X189HFigure 37X). 

 

Figure 37: NRM Config Plug-in 
2. Modify the NRM Config settings as needed. 

Adjusting Setpoints 
The Setpoints plug-in contains all adjustable setpoints within the 
selected application. 

To adjust setpoints: 

1. Click Setpoints. The Setpoints functions and values appear  
( X190HFigure 38X). 

 
Figure 38: Setpoints Plug-in 

2. Modify the Setpoint settings as needed. 
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Adjusting Parameters 
The Parameters plug-in contains all adjustable system parameters 
within the selected application.  
To adjust parameters: 

1. Click Parameters. The Parameters functions and values appear 
( X191HFigure 39X). 

 
Figure 39: Parameters Plug-in 

2. Modify the system parameters as needed. 

Adjusting Proportional plus Integral plus Derivative (PID) 
Parameters 
The PID Parameters plug-in contains all adjustable tuning parameters 
(proportional bands, integration times, and saturation times) within the 
selected application.  

To adjust PID parameters: 

1. Click PID Parameters. The PID Parameters functions and values 
appear (X192HFigure 40X). 

 
Figure 40: PID Parameters Plug-in 

2. Modify the PID Parameters as needed. 
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Adjusting the Exception Day Calendar 
The Calendar plug-in guides you in the definition of the exception day 
calendar. 

To adjust the exception day calendar: 

1. Click Calendar. The Calendar appears (X193HFigure 41). 

 
Figure 41: Exception Day Calendar Plug-in 

2. Modify the calendar as needed. 

a. Click a day to highlight that day, or click and drag across the 
calendar to highlight a range of days. 

b. Right-click on the highlighted day(s) and select the desired 
option from the menu. 

c. To change a day’s exception, right-click that day and select the 
desired option from the menu. 

3. Click Apply. 

Adjusting the Weekly (Occupancy) Schedule 
The Schedule plug-in guides you in the definition of the Weekly 
(Occupancy) Schedule. 

To adjust the weekly occupancy schedule: 

1. Click Schedule. The Weekly Schedule plug-in appears  
( X194HFigure 42X). 
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Figure 42: Weekly (Occupancy) Schedule Plug-in 

Note: The Roof Top Unit (RTU) application uses a different 
Occupied Schedule plug-in (X195HFigure 43 X).  

 
Figure 43: Schedule Plug-in for use with RTUs 

2. Modify the schedule as needed. 

a. Select the check boxes for the days that use the schedule 
configuration ( X196HFigure 42X, only). 

b. Double-click a day to display a Fine Tuning dialog box  
( X197HFigure 43X, only). 

c. Click and drag across the schedule to highlight a time range for 
that day. 

d. Right-click on the highlighted time range and select the desired 
option from the menu, or double-click a time range to display 
the Fine Tuning dialog box. 

e. To change a time range’s settings, click on the time range and 
drag it to the desired setting or double-click a time range to 
display the Fine Tuning dialog box. 

3. Click Apply. 
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Viewing the Configuration Summary 
The Config Summary plug-in provides a summary for all 
configuration setting, setpoint, and parameter adjustments made during 
the configuration session. If you want to change anything, edit the 
appropriate configuration(s) you made prior to this step. 

To view the configuration summary: 

1. Click Config Summary. The Configuration Summary report 
appears (X198HFigure 44X). 

2. View the summary here or to save the summary to a document, 
right-click on the summary information and select Copy to 
clipboard, then paste it into a document (a Notepad document 
retains better formatting than a Word document). 

 
Figure 44: Configuration Summary Window 

Viewing Input and Output Assignments 
The FX Hardware plug-in provides input and output assignment for 
the target controller based on the selected application and 
configuration. If you want to change anything, edit the appropriate 
configuration(s) you made prior to this step. 

To view the Input and Output assignments: 

1. Click FX Hardware. The Required Inputs and Outputs summary 
report appears (X199HFigure 45 X). 

2. View the summary here or, to save the summary to a document, 
right-click on the summary information and select Copy to 
clipboard then paste it into a document (a Notepad document 
retains better formatting than a Word document). 
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Figure 45: Required Inputs and Outputs Window 

3. Click Next to select the interface(s) and device I/Os (X200HFigure 46 X).  

Selecting the User Interface(s) and Network Protocol 
The Choose Interfaces (X201HFigure 46X) dialog box provides User Interface 
and Network Protocol options for the target controller based on the 
application and configuration settings you selected. If you do not see 
the options you want to use, click Previous to return to the 
configuration plug-ins and edit the appropriate configuration(s) you 
made prior to this step. 

To select the user interface(s) and network protocol: 

1. Choose the desired User Interface(s). 

2. Choose the desired Network Protocol. 

 

Figure 46: Choose Interfaces Dialog Box 
3. Click Next to select the FX controller. The Select Target Device 

dialog box appears (X202HFigure 47X). 

Selecting the Target Device 
The Select Target Devices dialog box (X203HFigure 47X) provides FX 
controller options for the target controller based on the selected 
application and configuration. 
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Figure 47: Select Target Device Dialog Box 
To select the target device: 

1. Select a device and click Next. The Configure Hardware I/O 
window appears (X204HFigure 49X). 

Note: If the device you want to use does not appear in the list of 
the Approved Devices Tab (see X205HFigure 47X), click the Rejected Devices 
tab and view the Reason for the rejection (X206HFigure 48X). You can also 
click the Exclusion Details button  for more details. 

Then, based on the rejection reasons, you can click Previous to return 
to the configuration plug-ins and edit the appropriate configuration(s) 
to configure the device so it is approved. 

 

Figure 48: Rejected Devices Tab 

Configuring the Hardware I/Os 
The Configure Hardware I/O dialog box is organized into tabs based 
on I/O type (Analog Inputs, Analog Outputs, Digital Inputs, and 
Digital Outputs). 

To configure the hardware I/Os: 

1. Change the Sensor Type and Channel Number for the desired 
objects (X207HFigure 49X). 
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Figure 49: Configure Hardware I/O Window 
Note: Each Channel Number must be unique. The Status alerts you 
with a yellow alert symbol if multiple channels are assigned the same 
number. Correct the Channel Number so each channel has a unique 
number and all status symbols are green. 

 

Figure 50: Channel Number Status Alert 
2. Click Next. The Generate Application dialog box appears  

( X208HFigure 51X). 

Generating the Application Files and Documents 
This is the final step in creating and generating the Application files 
and documents (X209HFigure 51 X). 

To generate the application files and documents: 

1. Edit or enter a Name for the Application. 

2. Enter the name of the Application designer in the Prepared By 
field (or department name, employee ID, other relevant 
information to the preparer), if desired. 

3. Enter information relevant to the Application, design, notes for 
others who may use the Application in the future, or other 
information in the Description field, if desired. 

4. Navigate to the directory folder where you want the application 
files to be exported (if different than the Application File default 
location shown). 
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5. Change the name of the .apd file in the Application File field, if 
desired. But do not change the .apd extension. 

 

Figure 51: Generate Application Window 
6. Click Finish. 

The application files and documentation are generated, and the 
Application Wizard closes. The bottom of the FX Builder window 
displays a status for each application object loaded. When all 
application objects are loaded the Generating Documentation 
status bar displays in the middle of the screen (X210HFigure 52X). 

 

Figure 52: Generating Documentation Status Bar 
7. Click OK when the Application Compile completed! dialog box 

appears (211HFigure 53). 

 

Figure 53: Application Compile Completed! Dialog Box 
The Application and its corresponding files and documentation are 
now generated. 
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Viewing Generated Application and Documentation Files 
To view generated application and documentation files, go to the 
destination folder (X212HFigure 54X) that was designated in the Application 
File field (see 213HFigure 51). 

 

Figure 54: Exported Application and Documentation Files 
The Application Wizard generates Application and documentation 
files. The type of generated files depends on the selections made in the 
Application Wizard Preferences dialog box (214HFigure 29) and 
Configuration Options plug-ins (215HFigure 36). 

See 216HGenerated Application and Documentation Files for a description 
of the different types of files. 

Reviewing and Changing an Exported Application File 
The Application Wizard includes a synchronization feature that allows 
you to match an exported application file (*.apd) to its template. This 
feature allows you to use the Application Wizard screens to review 
and/or change any of the options, settings, or selections made to an 
exported application file. 

To use this feature: 

1. Open the Application Wizard (File > Application Wizard). 

2. Click on Synchronize Application Template . . . (see 217HFigure 55). 
The Open Application dialog box appears (218HFigure 56).   
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Figure 55: Synchronize Application Template 
 

 

Figure 56: Open Application Dialog Box 
3. Navigate to the location of your exported *.apd file, select it and 

click Open. The Application Wizard reappears showing if the 
selected application matches an installed template (see 219HFigure 57). 
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Figure 57: Application Template Match 
4. Click Next. The Application Wizard appears, showing the actual 

configuration settings, setpoints, adjustment parameters, user 
interface selection, protocol choice, target controller selection, and 
I/O configurations that were originally made before the application 
file was exported. You can now use the Application Wizard to 
view and/or change these settings as desired.    

Creating an Application (Programming Approach) 
Creating an Application Using the Programming Approach 
This is a high-level overview of the steps used to create an application 
using the programming approach. 

1. Select the target device. 

2. Create the control algorithm with the Application Editor. 

3. Expose the application object input/output references as either 
volatile or permanent (nonvolatile) application points. 

4. Define application point details using the application points 
plug-in. 

5. Enable trends and events (optional) using the application points 
plug-in. 

6. Configure trends and events (optional) using their corresponding 
plug-ins. 

7. Simulate the control algorithm with the Simulator plug-in. 
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8. Create and format the user interfaces (optional) using the Display 
plug-in. 

9. Create and format the Web interface (optional) using the Web Site 
plug-in. 

10. Create and format the network profile using the Protocol plug-in. 

Creating a New Application 
1. In FX Builder, select File > New Application. The New 

Application window appears (220HFigure 58). 

 
Figure 58: New Application 

2. From the list of devices, select the device that you want to create 
an application for. 

When you highlight a target device, a brief description of the 
device appears on the bottom of the New Application window. For 
additional information, click on the Data Sheet button to access a 
copy of the technical bulletin of the device. 
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3. Enter the following information: 

• Name (required) – the name of the application 

• Category (optional) 

• Model (optional) 

• Prepared by (optional) 

• Description (optional) 

• Firmware (required) - the firmware version of the targeted 
device. This selection determines which objects and services 
are available in the application view. See X221HTable 4X for details on 
the version numbers. 

4. Click OK. FX Builder adds the device object to the Control View 
( X222HFigure 59X). 

 
Figure 59: Target Device Added to Control View 

At this point, you can create and edit the control algorithm using the 
Application Editor. 

Accessing the Application Editor for the Control View 
To access the Application Editor from the Control View: 

1. Double-click on the device object. 

2. Right-click the device object and select Edit Control Logic. 

3. From the Device menu, select Edit Control Logic. 
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Table 4: FX Controller Versions 
Latest FX 
Tools 
Versions 

FX Controller Latest 
FW 
Version 

Version 
in FX 
Builder

Date 
(Year, 
Week) 

FX Applications Supported 

 
MD20 Master 
Display N2 Models 

3.30 V000 0843 Network Application using 
Gateway Object 
Distributed Application as Master 
Device (up to 8 FX Slaves) 

 
MD20 Master 
Display LON Models 

3.30 V000 0843 LONWORKS Interface 
Network Application using 
Gateway Object 
Distributed Application as Master 
Device (Up to 8 FX Slaves) 

 
FX16x Master 
Controller Rev. B 
with FX IO Modules 

7.1.5 V004 0913 Distributed Application as Master 
Device (up to 16 FX Slaves) 
Network Application using 
Gateway Object 
Stand-Alone Application 
Application Download/Upload 
BACnet Network Interface 
FX IO Modules 

 
FX16x Master 
Controller Rev. B 

6.30 V002 0752 Distributed Application as Master 
Device (up to 16 FX Slaves) 
Network Application using 
Gateway Object 
Stand-Alone Application 
Application Download/Upload 
BACnet Network Interface 

 
FX16x Master 
Controller Rev. A 
with FX IO Modules 

7.1.1 V003 0913 Distributed Application as Master 
Device (up to 16 FX Slaves) 
Network Application using 
Gateway Object 
Stand-Alone Application 
Application Download/Upload 
FX IO Modules 

 
FX16x Master 
Controller Rev. A 

5.20 V001 0752 Distributed Application as Master 
Device (up to 16 FX Slaves) 
Network Application using 
Gateway Object 
Stand-Alone Application 
Application Download/upload 

FX Builder: 
5.x 
FX CommPro 
N2: 5.x  
FX CommPro 
LON: 2.9.2 
FX CommPro 
BACnet: 5.x 
MDLON 
Loader: 1.2.0 

 
FX16D and FX16X 
Master Controller 

4.50 V000 0840 Distributed Application as Master 
Device (up to 16 FX Slaves) 
Stand-Alone Application 

Continued on next page . . .  
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Latest FX 
Tools 
Versions 
(Cont.) 

FX Controller Latest 
FW 
Version 

Version 
in FX 
Builder

Date 
(Year, 
Week) 

FX Applications Supported 

 
FX15 Field 
Controller Rev. A 

4.40 
4.00 

V002 
V001 

0840 
0644 

Distributed Application as Slave 
Device 
Stand-Alone Application 

 
FX15 Field 
Controller 

2.05 V000 0518 Distributed Application as Slave 
Device 
Stand-Alone Application 

 
FX15 Universal 
Controller Rev. A 

4.40 V001 0840 Distributed Application as Slave 
Device 
Stand-Alone Application 

 
FX15 Universal  

2.05 V000 0518 Distributed Application as Slave 
Device 
Stand-Alone Application 

 
FX14 Field 
Controller Rev. B 

5.1.7 V0003 0913 Distributed Application as Slave 
Device 
Stand-Alone Application 
BACnet Network Interface 

 
FX14 Field 
Controller Rev. A 

3.21 V0002 0843 Distributed Application as Slave 
Device 
Stand-Alone Application 

 
FX14 Field 
Controller 

1.03 
 

V0001 0622 Distributed Application as Slave 
Device 
Stand-Alone Application 

FX Builder: 
5.x 
FX CommPro 
N2: 5.x  
FX CommPro 
LON: 2.9.2 
FX CommPro 
BACnet: 5.x 

 
FX07 Field 
Controller Rev. A 

5.1.7 V0002 0913 Distributed Application as Slave 
Device 
Stand-Alone Application 
BACnet Network Interface 

Continued on next page . . .  
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Latest FX 
Tools 
Versions 
(Cont.) 

FX Controller Latest 
FW 
Version 

Version 
in FX 
Builder

Date 
(Year, 
Week) 

FX Applications Supported 

 

 
FX07 Field 
Controller 

3.21 V0001 0843 Distributed Application as Slave 
Device 
Stand-Alone Application 

 

 
FX06 Controller  
Rev. A 

3.21 V0002 0843 Distributed Application as Slave 
Device 
Stand-Alone Application 

 

 
FX06 Controller 

1.03 V0001 0622 Distributed Application as Slave 
Device 
Stand-Alone Application 

 

 
FX05 Advanced 

2.00 V0002 0524 Distributed Application as Slave 
Device 
Stand-Alone Application 

 MUI Version 3 
MUI Version 2 

 

3.40 
2.43 

V3 
V2 

0752 
0545 

Optional Display for FX16, FX15, 
FX14, FX07, FX06 
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Creating the Control Algorithm 
Working with the Application Editor 
To create an application algorithm, select the desired application 
objects, configure them, and connect them in the Application Editor. 

Application Objects 
FX Builder includes a large set of configurable objects to create the 
control algorithm. 

IMPORTANT: Not all application objects are supported by every device and 
firmware revision. The list of supported objects is unique to each device and 
firmware revision. Refer to the technical bulletin of the target device to 
ensure that the desired object is included. 

IOM (Extension) Objects 
IOM Objects are used to add additional inputs and outputs to an 
application. X223HTable 5X displays the I/O objects included in FX Builder. 

Table 5: IOM (Extension) Objects 
IOM Object Icon Description 

 
IOM Analog Input (AI) 
 

Reads the analog input from the device and makes it 
available to the application. The Analog Input object 
scales the AI value. This object then limits the value 
according to the channel type and the high and low 
range parameters. The object also has all the 
necessary filters to limit and suppress the effect of 
unstable measurement. 

 
IOM Digital Input (DI) 

Reads the digital input from the device and makes it 
available for the application.  

 
IOM Input Counter 

Reads the pulse input from the device and makes it 
available for the application. 

 
IOM Analog Output (AO) 

Manages the analog outputs (0-10 V) of the device. 

  
IOM On/Off Output 

Manages the On/Off hardware output. Use the output 
to control either Triac or Relay outputs. 
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Input/Output (I/O) Objects 
X224HTable 6X displays the I/O objects included in FX Builder. 

Table 6: Input/Output (I/O) Objects 
I/O Object Icon Description 

 
Analog Input  
 

Reads the analog input from the device and makes it 
available to the application. The Analog Input object 
scales the AI value. This object then limits the value 
according to the channel type and the high and low 
range parameters. The object also has all the 
necessary filters to limit and suppress the effect of 
unstable measurement. 
Not BACnet compatible. 

 
Analog Input Ext 

Enhanced AI object with additional exposed 
channels: 
• BACnet compatible 
• recommended for use with all available 

communication protocols 

 
Fan Command 

Based upon the Analog Input object. It converts a 
potentiometer input signal into various steps to 
describe the commanded speed of a fan. 

 
Occupancy Input 

Reads the digital input from the occupancy device 
(typically an occupancy sensor or manual occupancy 
switch) and makes it available to the application. 
Not BACnet compatible.  

 
Occupancy Input Ext 

Enhanced Occupancy Input object with additional 
exposed channels: 
• recommended for use with all Occupancy Input 

configurations 

 
Digital Input  

Reads the digital input from the device and makes it 
available for the application. 
Not BACnet compatible. 

 
Digital Input Ext 

Enhanced DI object with additional exposed 
channels: 
• BACnet compatible 
• recommended for use with all available 

communication protocols 

 
Temporary Occupancy 

Determines the effective occupancy based on an 
occupant override input. 

Continued on next page . . .  
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I/O Object Icon (Cont.) Description 

 
On/Off Output 

Manages the On/Off hardware output. Use the output 
to control either Triac or Relay outputs. 
Not BACnet compatible. 

 
On/Off Output Ext 

Enhanced On/Off Output object with additional 
exposed channels: 
• BACnet compatible 
• recommended for use with all available 

communication protocols 

 
Light-Emitting Diode 
(LED) 

Manages the LED next to the Occupant Override on 
the Room Command Module. 

 
Position Adjusting Time 
(PAT) Output 

Manages two output channels (one for increasing and 
the other for decreasing) for PAT control (also known 
as incremental control). Use the PAT output to control 
only Triac outputs. 
Not BACnet compatible. 

 
Position Adjusting Time 
Output Ext 

Enhanced PAT Output object with additional exposed 
channels: 
• BACnet compatible 
• recommended for use with all available 

communication protocols 

 
Fail-Safe Relay Output 

Manages the Fail-Safe Relay output. The Fail-Safe 
Relay is switched On or Off depending on the 
requested @VALUE. The physical status of the Fail-
Safe Relay Output is periodically compared with the 
requested @VALUE. In case they differ, a FAILURE 
alarm is triggered. 

 
Damper PAT Output 

Manages two output channels (one for increasing and 
the other for decreasing) for Damper PAT control 
(also known as incremental control). This object is 
very similar to the PAT Output object, except that the 
Damper PAT Output object does not include 
anti-sticking functions. 
Not BACnet compatible 

 
Damper PAT Output Ext 

Enhanced Damper PAT Output object with additional 
exposed channels: 
• BACnet compatible 
• recommended for use with all available 

communication protocols 

Continued on next page . . .  
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I/O Object Icon (Cont.) Description 

 
Duration Adjusting Time 
(DAT) Output 

Generates an On signal proportional to a time base. 
Use the DAT Output object to control only Triac 
outputs. 
Not BACnet compatible. 

 
Duration Adjusting Time 
Output Ext 

Enhanced DAT Output object with additional exposed 
channels: 
• BACnet compatible 
• recommended for use with all available 

communication protocols 

 
Hermetic Compressor 

Provides the logic, interlocking, and timing features 
required for operating a hermetic compressor. 
No mandatory connectable references. 

 
Hermetic Compressor 

Provides the logic, interlocking, and timing features 
required for operating a hermetic compressor. 
The HtgCommand input is a mandatory connectable 
reference. 

 
Hermetic Compressor 

Provides the logic, interlocking, and timing features 
required for operating a hermetic compressor. 
The ClgCommand is a mandatory connectable 
reference. 

 
Analog Output  

Manages the analog outputs (0-10 V) of the device. 
Not BACnet compatible. 

 
Analog Output Ext 

Enhanced AO object with additional exposed 
channels: 
• BACnet compatible 
• recommended for use with all available 

communication protocols 

 

Input Function Objects 
X225HTable 7X displays the Input Function objects included in FX Builder. 

Table 7: Input Function Objects 
I/O Object Icon Description 

 

Provides a count of the Off to On logic transitions of 
the defined digital input channel. You can configure 
this object to count input pulses (having a maximum 
50 Hz frequency). 

Numeric Function Objects 
X226HTable 8X displays the Numeric Function objects included in FX Builder. 
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Table 8: Numeric Function Objects 
Numeric Function 
Object Icon 

Description 

 
Average (2-Input) 

Calculates a weighted average between two values. 
To calculate the average among more values, use 
the 8-Input Average object. 

 
Average (8-Input) 

Calculates a weighted average between eight values. 
To calculate the average among more values, apply 
the object in series with proper weight. 

 
Extended Calculation 

Performs an addition, multiplication, or square root 
function between two values. 

 
Compare 

Compares two variables and creates a binary logic 
output. You use this object to drive an On/Off output 
from a numeric value. 

 
Event Counter 

Provides a way to count events based on logical 
transitions. A flag is set when full scale is reached. 

 
Butterworth Filter 

Performs a low pass, second order Butterworth 
filter on the input. You typically used this filter to 
condition the input for Pattern Recognition Adaptive 
Control (PRAC). 

 
Integrator 

Performs integration on the value of a numeric input. 
The integration rate is determined by a time constant. 
You can set the integrator to zero by a logic reference 
connected to a reset input. When the output reaches 
a programmable full-scale value, the integrator 
full-scale logic status is set and the output value 
remains at full scale until reset. Alternatively, the 
output value is set to zero and integrating restarts. 

 

 
Maximum (2-Input) 

Calculates the maximum between two values. To 
calculate the maximum among more values, use the 
8-Input Maximum object. 

 
Maximum (8-Input) 

Calculates the maximum between eight values. To 
calculate the maximum among more values, apply 
the object in series. 

 
Minimum (2-Input) 

This object calculates the minimum between two 
values. To calculate the minimum among more 
values, use the 8-Input Minimum object. 

Continued on next page . . . 
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Minimum (8-Input) 

Calculates the minimum between eight values. To 
calculate the minimum among more values, apply the 
object in series. 

 
Psychrometric 1 

Calculates the dew point temperature, the humidity 
ratio, and the enthalpy of a from temperature and 
Relative Humidity (RH) inputs. Dew point temperature 
is the temperature when the relative humidity is 
100%. Enthalpy is the latent energy. Humidity ratio is 
also known as moisture content or mixing ratio. It is 
defined as W = Mw/Ma where Mw is the mass of 
water vapor in moist air sample and Ma is the mass 
of dry air in moist air sample. 

 
Psychrometric 2 

This object calculates the relative humidity, humidity 
ratio, and enthalpy from dry bulb temperature and wet 
bulb temperature inputs. Enthalpy is the latent 
energy. Humidity ratio is also known as moisture 
content or mixing ratio. It is defined as W = Mw/Ma 
where Mw is the mass of water vapor in moist air 
sample and Ma is the mass of dry air in moist air 
sample. 

 
Ramp 

Generates a linear rate ramp from an initial value to a 
setpoint. It is typically used to gradually start up 
equipment. 

 
Selector (2-Input) 

Selects one of its two inputs based on the status of its 
pilot input. 

 
Selector (8-Input) 

Selects one of its eight inputs based on the status of 
its selector input. 

 
Segment 

Performs a nonlinear transform function on its input 
value. It allows up to 15 segments. 

 
Span 

Linearly scales and biases an input value. This object 
differs from the Segment object in the way that the 
controller can dynamically adjust the transfer function 
rather than from a fixed configuration. 

 
Timer 

Generates time-based function and activates its 
output accordingly. It features a random on-delay to 
use in applications to prevent high inductive loads 
from starting at the same time. 

 
Timer with Reset 

Generates time-based function and activates its 
output accordingly. This object features a random on-
delay that you can use in applications to prevent 
high-inductive loads from all starting at the same 
time. The Reset Input is mandatory. 

Continued on next page . . . 

 

 

 

 
Numeric Function 
Object Icon (Cont.) 

Description 
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Numeric Function 
Object Icon (Cont.) 

Description 

 
Time Counter 

Counts the time its input is in the On position. A flag 
is set when full scale is reached. This object is 
typically used to determine runtime. 

 
Storage Element 

Store a value in the permanent memory. The stored 
value is available after a reset action on the 
controller. 

 
Constant Value 

Outputs a user-defined constant value. This object 
only has internal application purposes. 

 
Estimated Weighted 
Moving Average 
(EWMA) 

Summarizes data into a single value similar to a 
mean, except that it places greater weight on more 
recent data. The EWMA object is useful for data 
analysis and diagnostics. 
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Control Function Objects 
X227HTable 9X displays the Control Function objects included in FX Builder. 

Table 9: Control Function Objects 
Control Function 
Object Icon 

Description 

 
On/Off Controller 

Generates an On/Off output based on the difference 
between the variable being controlled (process 
variable) and the desired value (setpoint). 

 
Proportional plus 
Integral plus Derivative  

Generates a PID output in response to the difference 
between the desired setpoint and the process 
variable. 

 
Automatic Economizer 

Provides a logical output based on the availability of 
free cooling. Free cooling is the use of outside air to 
lessen the load experienced by the cooling coil. This 
process reduces the need for mechanical cooling 
from the controlled equipment that provides energy 
savings. You can define the operating mode or 
strategy used by the object to determine free cooling 
availability, between one of the following: 
• automatic (depending on connected sensors) 
• differential enthalpy (difference between outdoor 

enthalpy and room/return enthalpy) 
• single enthalpy (outdoor enthalpy only) 
• differential temperature (difference between 

outdoor temperature and room/return 
temperature) 

• dry bulb (outdoor temperature only) 
You can override the Economizer object to adapt the 
damper position to the status of the equipment. 

 
Fan Controller 

Drives a multi-speed or variable-speed fan. This 
object provides all the logic and interlocking features 
required for such an application. 

 

Obsolete Objects 
Use this folder to locate objects that have been substituted by new 
enhanced objects. The obsolete objects included still work but are now 
red-crossed. 

Logic Function Objects 
X228HTable 10X displays the Logic Function objects included in FX Builder. 
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Table 10: Logic Function Objects 
Logic Function Object 
Icon 

Description 

 
Or (2-Input) 

Performs the Boolean or function on its 2 inputs. 
Each input can be negated 

 
Or (8-Input) 

Performs the Boolean or function on up to 8 inputs. 
Four inputs are negated. 

 
And (2-Input) 

Performs the Boolean and function on its 2 inputs. 
Each input can be negated. 

 
And (8-Input) 

Performs the Boolean and function on up to 8 inputs. 
Four inputs are negated. 

 
XOR (2-Input) 

Performs the Boolean xor (Exclusive OR) function on 
its 2 inputs. The xor operation produces a result of 1 
if exactly one of its inputs is 1; otherwise, it produces 
a result of 0 if its inputs are both 0 or both 1. Each 
input can be negated. 

 
XOR (8-Input) 

Performs the Boolean xor (Exclusive or) function on 
up to 8 inputs. The xor operation produces a result of 
1 if exactly one of its inputs is 1; otherwise it 
produces a result of 0 if its inputs are all 0 or all 1. 
Each input can be negated. 

 
Not 

Performs the Boolean not function (also known as 
negate or complement) on its four inputs. 

 
Output Override Logic 

Coordinates overrides coming from different sources 
into the appropriate override format required to drive 
the output. 

 
Enumeration Override 

Converts up to 16 states of an enumeration into some 
other enumerated states. Use this object for 
hvac_mode, occup, hvac_emerg, and/or UNVT_logic. 
For example, you can use this object to block some 
states that the controller receives from the network. 

 
Enumeration Logic 

Prioritizes between two enumerated inputs. Use this 
object for hvac_mode, occup, hvac_emerg, 
UNVT_logic. For example, the priority between User 
Interface and Network mode can be done using this 
object. 

 
Programmable Logic 
Controller (PLC) 

Performs the execution of a programmable logic 
control defined by a list of instructions. This object 
can perform any function built using ladder logic or 
state machine. It features all the basic instructions of 
a standard PLC.  
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Alarms Objects 
X229HTable 11X displays the Alarm objects included in FX Builder. 

Table 11: Alarms Objects 
Alarms Object Icon Description 

 
Analog Alarm 

Generates an alarm status (high or low) from an 
analog value. The alarm can be a fixed value or 
referred to a setpoint. This alarm resets automatically 
with a differential. 

 
Manual Reset Binary 
Alarm 

Allows you to define the number of automatic resets 
that can occur before a manual reset becomes 
mandatory. You can connect this alarm to a digital 
input object or to an automatic reset alarm object. 
This object locks its output when the Off to On input 
transition frequency exceeds a user-defined level and 
the output can be unlocked only by a manual reset. 
The reset is based on a digital reference that can be 
a digital input or a display key. 

 
Compressor Envelope 

Allows you to define conditions not compatible with 
the usage of compressor operated systems. This 
object generates an alarm output if the user-defined 
conditions are not suitable for the compressor to run. 
It can be applied to air-to-air and water-to-air units. 

 
Out of Range 

Imposes a user-defined limit range on its input value. 
If the input value is within the high and low limits, then 
the object passes the input value through to its output 
and the status is set to off. As soon as the input 
value goes outside the limits, the output is set to 
invalid and the status reports on until the input value 
returns within the limits. 

 

Special Functions Objects 
X230HTable 12X displays the Special Functions objects included in FX 
Builder. 

Table 12: Special Functions Objects 
Special Functions 
Object Icon 

Description 

 
Temperature Setpoint 

Calculates the heating and cooling temperature 
setpoints for the controller. The setpoints are derived 
from the configured setpoints, the absolute setpoint, 
the setpoint offset, the setpoint shift, and the 
occupancy mode. The setpoints are calculated using 
the Asymmetrical Method of Setpoint Calculation as 
defined in the Space Comfort Controller Template. 

 
General Setpoint 

Calculates the working setpoint for the controller. The 
working setpoint is calculated depending on the 
action type and occupancy mode of the controller and 
is based on Local and Remote setpoint values. The 
working setpoint calculation can be altered by limits, 
biases, offsets, and ratio values. 

Continued on next page . . . 



 FX Tools Software Package - FX Builder User’s Guide 

 

66 

Special Functions 
Object Icon (Cont.) 

Description 

 
Emergency/Application 
Mode 

Manages the heat/cool and emergency overrides for 
the application. This object is based on low ambient, 
OFF state, powerup, and various network commands. 
These can be Digital input or Network Variable 
inputs. 

 
Binary Sequencer 

Provides control of 1-4 binary outputs (stages) as a 
function of a percentage of the input. The stages are 
controlled in sequence according to binary code. The 
sequencer always selects the appropriate stage 
combination for the requested output, with the 
possibility to add a stage delay between the changing 
of a state combination. The object automatically 
assigns load factors to all stages so when the 
selected output is equal to 100%, all stages are 
switched ON. 

 
Occupancy Mode 

Generates the effective Occupancy Mode for the 
application depending on a manual command, an 
occupancy sensor, and occupancy schedules. 

 
Real-Time Clock 

Sets the time of the hardware timekeeper chip and 
makes it available to the application and network. 
This object is meant to be used with Real-Time Clock 
plug-in card for the FX05 or FX10. 

 
Clock and Date Set 

Sets the time and date of the hardware timekeeper 
chip and makes it available to the application. This 
object also manages automatic summer/winter time 
change over. 

 
Sensor Failure 

Allows you to define the default operation of an 
output in case of sensor failure. The operation can be 
always ON, always OFF, or based on a weighted 
running average that represents the output function 
over time. 

 
Source Mode 

Generates the appropriate application mode based 
on source temperature. For example, use this object 
to stop the fan when the coil is inefficient (to avoid 
blowing cold air on a heat request before the coil gets 
hot). You can also use this object in two-pipe 
applications, to allow switching between heating and 
cooling modes (either from a temperature sensor or 
from a switch). 

 
System Resources 

Transfers important information on the status of the 
operating system to the application. Use this object to 
run the application in a default mode. 

Continued on next page . . . 
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Special Functions 
Object Icon (Cont.) 

Description 

 
Sequencer 

Provides the control of 1-4 outputs (stages) as a 
function of the value of the INPUT and the state of 
four logic (STAGENDISABLE) inputs. Use this object 
to control multi-stage equipment, maintaining 
minimum ON/OFF times, inter-stage delays, and 
sequencing loads. The output stages are controlled in 
sequence according to different strategies as Step 
Mode (First In Last Out [FILO]), Sequential Mode 
(First In First Out [FIFO]), Equal Runtime, or Equal 
Startup. Variations are also available for compressor 
circuit with Single Oil Pump or for Pump Down. This 
object can also perform Vernier Networks® control 
providing full adjustment. 

 
Array Sequencer 

Operates as the Sequencer but controls up to  
8 outputs (stages). 

 
Semi-hermetic 
Compressor 

Provides the means for driving a semi-hermetic 
reciprocating compressor in refrigeration or air 
conditioning applications. This object is meant to take 
its input from a sequencer object. 

 
Summer/Winter 
Compensation 

Calculates setpoint shifts based on the outdoor air 
temperature. The Setpoint Calculation object uses 
these shifts to calculate the effective occupancy 
setpoints. 

 
Load Manager 

Calculates the load required by an installation and 
formats it for a sequencer. This object also manages 
lead/lag between two sequencers. 

 
Optimal Start/Stop 

Calculates the minimum time to bring a controlled 
zone temperature to a desired condition at occupancy 
with a heating or cooling plant. This object also 
calculates the optimal stop time to maintain the 
desired conditions up to the end of the occupancy 
time. 
The Optimal Start/Stop object algorithm is adaptive. 
The heating and cooling thermal characteristics of the 
building are measured during the preheating or 
precooling cycles and are used in the operations. 
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Schedulers Objects 
X231HTable 13X displays the Schedulers objects included in FX Builder. 

Table 13: Schedulers Objects 
Schedulers Object 
Icon 

Description 

 
On/Off Time Scheduler 

Provides the control of a logic output as a function of 
a programmable event schedule, day of the week, 
calendar, time, and exception days condition. To 
define Start and Stop conditions, you need to 
configure events using a specific plug-in. 

 
Weekly Occupancy 
Scheduler 

Provides Time Schedule capability to drive the 
occupancy status based on day of the week, 
calendar, and time information. Use this object to 
change occupancy status or to drive the Optimal 
Start/Stop object. To define Start and Stop 
conditions, you need to configure events using a 
specific plug-in. 

 
Exception Calendar 

Generates exceptions for the days of the week. 
These exceptions are normally used to define 
holidays. The Exception Day object defines a period 
with a begin and end date. If the present date is 
within an exception day period, the day type is set to 
Alternate date. 

 

Refrigeration Objects 
X232HTable 14X displays the Refrigeration objects included in FX Builder. 
Table 14: Refrigeration Objects 
Refrigeration Object 
Icon 

Description 

 
Accumulative Defrost 

Defines the defrost cycle in applications with an 
outdoor air heat exchanger. Use this object in the air 
conditioning application heating mode to avoid and 
melt ice buildup on the heat exchanger. This object 
takes into account runtime to optimize the period of 
the cycle. 

 
Refrigeration Defrost 
Initiation 

Allows you to define logic necessary to start up a 
defrost cycle. This object takes input from a network 
variable, a timer, a time scheduler, or a digital input 
object and organizes the priority. This object also 
features an adaptive defrost initiation mode. 

Continued on next page . . . 



 FX Tools Software Package - FX Builder User’s Guide 

  

69

Refrigeration Object 
Icon (Cont.) 

Description 

 
Refrigeration Defrost 

Manages the defrost cycle for one evaporator that 
can be part of a line up. It is intended for refrigerated 
and frozen food temperature applications. You must 
use this object in conjunction with a Defrost Initiation 
object if used as a stand-alone device. 

 
Refrigeration Saturation 
Properties 

Calculates thermodynamic properties for the specific 
refrigerant in use. Depending on the refrigerant type, 
pressure, and transformation type values, the object 
retrieves the temperature value of the isothermal 
curve that crosses the specified Saturated Points 
Line at the given pressure. Available saturated lines 
are the Saturated Liquid (Bubble) and Saturated 
Vapor (Dew). This object maps the Pressure-
Enthalpy diagrams of the most common refrigerants. 

 

Unit Conversion Objects 
X233HTable 15X displays the Unit Conversion objects included in FX Builder. 
Table 15: Unit Conversion Objects 
Unit Conversion 
Object Icon 

Description 

 
SNVT Hvac Status 
Generator 

Creates the SNVT_hvac_status (required in the 
LONWORKS Space Comfort Controller Profile). 

 
UNVT_logic to 
SNVT_state 

Converts UNVT_logic flags into a SNVT_state 
variable type (required in various LONMARK® 
Profiles). 

 
SNVT_state to 
UNVT_logic  

Converts a SNVT_state variable type into 
UNVT_logic flags. 

 
Enumeration to 
UNVT_logic 

Converts an enumeration value into UNVT_logic 
flags. 

 
SNVT_switch to 
UNVT_logic 

Converts a SNVT_switch into UNVT_logic and 
reverse. 

Continued on next page . . . 
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Unit Conversion 
Object Icon (Cont.) 

Description 

 
SNVT_lev_disc to 
SNVT_switch 

Converts a SNVT_lev_disc (used mostly in 
Refrigeration Profiles) into SNVT_switch and reverse. 
Both conversions can be performed at the same time. 

 
Convert Format 

Converts any value into a defined format. 

 
SNVT Chiller Status 
Generator 

Creates the SNVT_chlr_status (required in the 
LONWORKS Chiller Profile). 

 

Extension Modules Objects 
X234HTable 16X displays the Extensions objects included in FX Builder. 

Table 16: Extension Modules Objects 
Extension Modules 
Object Icon 

Description 

 
XT9100 

Configures the extension module XT91D00 and the 
expansion modules XP91D0x for interaction with the 
application. 

 
Gateway 

Provides the supervisory interface between the FX16 
Master Controller or MD20 Master Display and N2 
Open devices. This object manages up to 255 inputs 
and 32 outputs. This object defines the network 
address, the data points to read and write to and from 
connected N2 devices. This object can also enable 
and disable the communication to the connected 
devices. 

 

Network Sensor Objects 
X235HTable 17X displays the Bus Sensor objects included in FX Builder. 

Table 17: Network Sensor Objects 
Network Sensor 
Object Icon 

Description 

 

Configures the Network Room Module (NRM) for 
interaction with the application. 
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Adding Application Objects 
You can locate application objects in the Objects toolbar. The objects 
are organized in folders. 

To add application objects: 

1. In the FX Builder Application Editor, select View > Object Basket 
to display the Object choices (236HFigure 60X). 

Note: You can also click the Show Object Basket icon  on the 
toolbar. 

 
Figure 60: FX Builder Objects Toolbar 

2. Click the object you want. 

3. Position the mouse on the Application Editor canvas where you 
want to position the object and click again. The object is added to 
the Application Editor canvas. 
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Configuring Standard Application Objects 
Each application object contains a data sheet describing its operation, 
connectable references, and attributes. To view the object data sheet, 
right-click the object and select View Data Sheet. 

Most objects contain editable attributes that allow you to configure the 
exact operation of the object. 

To configure a standard application object: 

4. In the FX Builder Application Editor, click on the blue, 
right-facing arrow at the bottom of the object icon. An attribute 
editor window appears below the object block (237HFigure 61X). 

5. Click on the desired attribute field and edit as needed. You can 
close the window by clicking the arrow again. 

 
Figure 61: Editing Object Attributes 

Configuring the Constant Value Object 
The Constant Value object is configured slightly differently than a 
standard object. You can expose the value attribute by clicking the 
blue, right-facing arrow at the bottom of the object; however, to set the 
data type of the constant value output, use the Constant Value object 
configuration plug-in. 

To configure the constant value object: 

1. Right-click on the Constant Value object and select Launch Plug In 
( X238HFigure 62X). The Constant Value configuration plug-in appears 
( X239HFigure 63X). 
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Figure 62: Launching Constant Value Configuration Plug-in 

 
Figure 63: Changing the Constant Value Type 

2. Choose the desired data type and click OK. 
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Configuring the Gateway Object 
The Gateway object allows the MD20 Master Display or FX16 Master 
Controller to supervise and monitor a network of N2 Open (including 
FX controllers with an N2 Open card) and N2 System 91 devices 
(DX-9100 and TC-910x). Through the gateway object, the master 
device reads, interprets, stores, and forwards the data points coming 
from N2 Open and N2 System 91 devices. 

The read values are made available to the application running in the 
master device through the input and output references of the Gateway 
object. 

The Gateway object can manage up to 255 inputs and 32 outputs and 
allows you to define the network address, the data points that the 
MD20 Master Display or an FX16 Master Controller has to read and 
write to and from connected N2 devices. The Gateway object can also 
enable or disable the communication toward the connected devices. 

The maximum number of Gateway objects supported in an application 
is 32. However, for an acceptable performance of the network, do not 
configure the Gateway objects in such a way that more than 350 
inputs/outputs are polled or written in one poll cycle. 

The Gateway object requires more involved configuration than 
standard application objects. 

IMPORTANT: Avoid repeated writes on the Electrically Erasable 
Programmable Read-Only Memory (EEPROM). The FX05, FX06, FX07, and 
FX14 controllers and System 91 devices have EEPROM and repeated writes 
may disable the controller.  
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Configuring the Gateway Object for an N2 Open Device 
To configure the Gateway object for an N2 Open device: 

1. In the Network View, right-click the Device and select Add 
Gateway > N2 Open from the Add Gateway menu. 

 
Figure 64: Adding a Gateway for an N2 Open Device 

A file chooser window appears (240HFigure 65) allowing you to 
identify the N2 Print File associated to the N2 Open device. The 
N2 Print File lists all available analog inputs, analog data floats, 
analog data integers, binary inputs, and binary data points 
associated with the N2 Open device. 

2. Select the N2 print file (*.prn) for the N2 device you want to add 
to the Gateway and click Open. 

The Gateway configuration plug-in appears (241HFigure 66). The 
Gateway configuration plug-in is a table listing all of the N2 points 
discovered from the Print File. 
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Figure 65: Selecting Print File 

3. Expand the N2 points to expose their attributes.  

Check boxes, data fields, and selector boxes appear, allowing you 
to configure how the point attributes are mapped to the application. 

 

Figure 66: Gateway Configuration Plug-In (N2 Open Device) 

4. To expose an N2 point attribute to the application, click the check 
box in the Use column. 

5. To set an initial value for a point attribute, check the box in the Init 
column, and set the initial value in the Init Value column. 

6. To make an N2 point attribute writable (input reference) in the 
application, click the check box in the Write column, and set the 
Write Mode field to: 

• Change of Value (COV) - send write command when value 
changes (analog or binary) 
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• slow writing - send write command every 10 polls (volatile 
points only) 

• fast writing - send write command on every poll (volatile 
points only) 

Note: The FX05, FX06, FX07, and FX14 devices use permanent 
parameters stored in the EEPROM of the device. The Gateway 
object interprets these parameters as inputs and allows you to 
choose a polling mode. We highly recommended that you choose 
the COV setting for those permanent parameters because 
continuous writing of the EEPROM memory causes permanent 
damage to the device. 

7. To make an N2 point attribute readable (output reference) in the 
application, click the check box in the Read column and set the 
Read Mode field to: 

• Change of State (COS) - use N2 Open COS poll to pick up 
changes (only works for N2 Open BI points) 

• fast poll - read on every poll 

• slow poll - read on every 10 polls 

The Gateway Objects Preview window shows how the Gateway 
object appears in the Application Editor canvas once you exit the 
Gateway configuration plug-in. Use this feedback make sure you 
are configuring the Gateway Object according to your 
requirements. 

8. After you add and configure all desired N2 point attributes, click 
Apply and then click OK. The FX Builder main screen appears, 
and the N2 device you added via the Gateway object appears in the 
Network View. 

 

Figure 67: N2 Device in Network View 

9. If necessary, change the N2 address to match the actual N2 address 
of the slave N2 device. 

The configured Gateway object appears in the first level of the 
Application Editor. The N2 point attributes you added are now 
exposed as connectable references of the Gateway object. You can 
connect inputs and outputs to them, expose them to the application 
point profile (allowing trends and events to be added), and add 
them to the user interface configuration of the master device. 
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Figure 68: Gateway Object Interface (N2 Open Device) 

By default, the Gateway object adds two additional inputs: 

• Address - used to modify the address via supervisory system. 

• Disable - used to enable/disable the communication with the 
connected device. 
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Configuring the Gateway Object for a System 91 Device 
To configure the Gateway object for a System 91 device: 

1. In the Network View, right-click the device. 

2. From the Sys91 menu, select Add Gateway > Sys91 > DX or TC 
( X242HFigure 69X). The Gateway configuration plug-in appears. The 
Gateway configuration plug-in is a table that lists the System 91 
programmable modules and points. 

  
Figure 69: Adding a Gateway for a System 91 N2 Device 

3. Expand the System 91 modules to expose their point attributes 
( X243HFigure 70X). 

Check boxes, data fields, and selector boxes appear, allowing you 
to configure how the point attributes are mapped to the application. 
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Figure 70: Gateway Configuration Plug-in (System 91 N2 Device) 

4. To expose a System 91 point attribute to the application, click on 
the check box in the Use column. 

5. To set an initial value for a point attribute, check the box in the Init 
column, and set the initial value in the Init Value column. 

6. To make a System 91 point attribute writable (input reference) in 
the application, click the check box in the Write column, and set 
the Write Mode field to: 

• COV - send write command when value changes (analog or 
binary). 

• slow writing - send write command every 10 polls (volatile 
points only). 

• fast writing - send write command on every poll (volatile 
points only). 

Note: The N2 System 91 devices (DX-9100, TC-9100) use 
Programmable Module Constants (PMK) parameters, which are 
stored permanently on the EEPROM of the device. The Gateway 
object interprets these parameters as inputs and allows you to 
choose a polling mode. We highly recommended that you choose 
the COV setting for those permanent parameters because 
continuous writing of the EEPROM memory causes permanent 
damage to the device. 

7. To make a System 91 point attribute readable (output reference) in 
the application, click the check box in the Read column and set the 
Read Mode field to: 

• fast poll (one poll per polling cycle) 

• slow poll (one poll per 10 polling cycles) 
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The Gateway Objects Preview window shows how the Gateway 
object appears in the Application Editor canvas once you exit the 
Gateway configuration plug-in. Use this feedback to make sure 
you are configuring the Gateway Object according to your 
requirements. 

8. After you add and configure all desired System 91 point attributes, 
click Apply and then OK. 

The FX Builder main screen appears, and the System 91 device 
you added via the Gateway object appears in the Network View. 

 

Figure 71: System 91 Device in Network View 

9. If necessary, change the N2 address to match the actual N2 address 
of the slave System 91 device. 

The configured Gateway object appears in the first level of the 
Application Editor. The System 91 point attributes you added are 
now exposed as connectable references of the Gateway object. You 
can connect inputs and outputs to them, expose them to the 
application point profile (allowing trends and events to be added), 
and add them to the user interface configuration of the master 
device. 

 
Figure 72: Gateway Object Interface (System 91 Device) 

By default, the Gateway object adds two additional inputs: 

• Address Input - used to modify the address via supervisory 
system. 

• Disable Input - used to enable/disable the communication with 
the connected device. 
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Configuring an IOM Object 
To configure an IOM object: 

1. In the Network view, right-click the device. The Add Iom menu 
appears (X244HFigure 73X). 

 
Figure 73: Adding an IOM Device 

2. From the Add Iom menu, select the desired Extension Module 
(XMxx). The Iom Module configuration plug-in appears  
( 245HFigure 74X). 

 

Figure 74: IOM Module Configuration Plug-in 
3. Click the plus sign (+) to expand the Input and Output categories 

( X246HFigure 75X). 
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Figure 75: IOM Module Configuration Plug-in with I/Os Expanded 

4. Select the check box in the Use column for each desired Input and 
Output Physical Channel ( X247HFigure 75X). Use the scrollbar to view 
additional I/O Physical Channels. 

5. Select the Universal Input type in the Use as column (either 
Analog Input or Binary Contact). 

6. Select the Digital Input type in the Use as column (Binary Contact 
or Pulse Counter). 

7. Click OK to save the selections and return to the FX Builder main 
screen. 

 
Figure 76: System 91 Device in Network View 

Note: In the Network area of the Main Screen, expand the plus 
sign next to the device to view the XMxx device(s). Right-click the 
XMxx device and select Edit to launch the IOM Module 
configuration plug-in, or Remove to delete the IOM module. 

8. Double-click the FX device in the Control View. The configured 
IOM object appears in the first level of the Application Editor. 

9. Click the Show IOM Object Basket icon on the toolbar . The 
IOM Object Basket appears (X248HFigure 77 X). 
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Figure 77: IOM Object Basket in Application Editor Window 
The IOM Object Basket contains the Input and Output objects created 
from the selections you made in the Iom Module configuration plug-in 
(see 249HFigure 75). The IOM objects differ from other objects in the 
following important ways (X250HFigure 78X). 

• The channel number of the IOM object is determined by the 
specific I/O object you bring to the canvas. Note the channel 
number in the description of each object in the IOM Object Basket. 
These channels were designated by the selections you made in the 
Iom Module plug-in (see X251HFigure 75X). 

• You cannot use more than one instance of an XM object. Once 
used, the object appears dimmed in the XM object basket. 

• Multiple XM devices can be created for a single object. Each XM 
device appears in the Devices field of the IOM Object Basket. 

 
Figure 78: IOM Object Basket 
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10. Click the Device and the desired object. 

11. Position the mouse on the Application Editor canvas where you 
want to position the object and click again. The object is added to 
the Application Editor canvas. 

Note: If you exit the Iom Module configuration plug-in and attempt 
to deselect an object that is already connected in your application, you 
get a Current Object is used inside application warning  
( X252HFigure 79X). 

 

Figure 79: Current Object is used Inside Application Dialog Box 
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Configuring the XT9100 Object 
The XT9100 object allows you to expand the input and output 
capabilities of the target controller by adding XT Extension and XP 
Expansion modules. The XT9100 object requires more involved 
configuration than standard application objects. 

To configure an XT9100 object: 

1. Right-click the Gateway object in the canvas and select Launch 
Plug In (X253HFigure 80X). The XT9100 window appears (X254HFigure 81 X). 

 

Figure 80: Launching XT/XP Configuration Plug-in 

 
Figure 81: XT9100 Configuration Plug-in 

2. Select Edit from the XT menu. 

3. Select the parameter to adjust. You can adjust the following 
communication parameters (X255HFigure 82 X): 

• priority 

• powerline frequency 

• behaviour on communication failure 

• maximum time between communication 
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• Digital Output (DO) pulse time 

 
Figure 82: Setting XT Parameters 

4. To add an XP module, select Add from the XP menu and select the 
desired XP module ( X256HFigure 83X). The XP module appears on the 
window. 

 
Figure 83: Adding XP Modules 

5. To configure an XP input/output channel, right-click the channel 
and select Edit. A list of attributes appears (X257HFigure 84). 

6. Select the desired attribute. The XP attributes you can edit include: 

• Sensor Type 

• Suppression 

• Range 

• Alarm 

• Square Root 

• Unit of 
Measure 

• High Range 

• Low Range 

• High Alarm Limit 

• Low Alarm Limit 

• Differential Alarm Limit 

• Filter Constant 

• Type 

• Contact Type 

• Prescaler 
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Figure 84: Editing Input/Output Channel Attributes 

Connections 
Every object has input and output references you connect to form the 
control algorithm. In addition, you can connect these object references 
to application inputs, outputs, and attributes, making them available 
for inclusion into the application point profile of the device. 

Adding Inputs, Outputs, and Attributes to the Application Editor 
Canvas 
You can connect object references to application inputs, outputs, and 
attributes, making them available for the application point profile of 
the device. These points include the following: 

 = Input 

 = Output 

 = Attribute 

To add an input, output, or attribute to the Application Editor canvas: 

1. Right-click the canvas and select Insert Input, Insert Output, or 
Insert Attribute. The Edit Name window appears allowing you to 
enter the name of the attribute (X258HFigure 85X). 

 
Figure 85: Entering Name of Input, Output, or Attribute 
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2. Enter the name and click OK. 

Note: Alternatively, you can double-click on object reference. 
A corresponding input or output is automatically created and 
connected to the object reference. 

Connection Rules 
To ensure that object references are connected appropriately, each 
object reference contains a list of compatible data types. FX Builder 
uses the LONWORKS Standard Network Variable Types (SNVTs) to 
define its data types. For example, SNVT 105 temp_p is used to define 
an absolute temperature. The exact data type of the application point is 
defined inside the application points plug-in. To make a connection 
from a source point to a destination point (or multiple destination 
points), the date types must be compatible. The SNVT Compatibility 
List of the destination must contain the SNVT ID of the source. See 
X259HFigure 86X. 

SOURCE DESTINATION

SNVT_ID
4

SNVT Compatibility List
1, 2, 4, 7, 14…..  

Figure 86: Source and Destination Compatibility 

In addition to compatibility, X260HTable 18X describes additional connection 
restrictions. 

Table 18: Application Points Connection Matrix 
Destination 
Source 

Application Output Object Inputs 

Application Input !  
No 

 

 
Object Output  

 

Same Object 

 

 

Other Object 

 

 

 

Note: In some cases, you can connect a unique source to multiple 
destination points simultaneously. For example, you can connect an 
application point input to different object inputs ( 261HFigure 87). 
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Figure 87: Source Point to Multiple Destination Points 

You can connect a destination point to only one source as shown in 
X262HFigure 88X. For example, you can connect an application output point to 
only one object output. 

 
Figure 88: Destination Point to Only a Source Point 
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Making Connections 
You can use two methods to make connections. 

To make a connection: 

• Click on the source and drag it to the destination. 

When you click on a source, all destinations with compatible data 
types are highlighted allowing you to easily identify potential 
destinations. When you click on input, output, or attribute icons, 
click on the small circle at the apex of the icon’s triangle. 

• Click on the source and drag it to an empty space on the canvas. 

A Fast Link window appears. This window allows you to check all 
desired destinations. This Fast Link feature is helpful when you 
connect a source to multiple destinations, even in different 
assemblies. You also do not have to search for the destination 
points within a large complex application (263HFigure 89). 

 
Figure 89: Fast Link Connection 

 
Figure 90: Successful Connection 
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Continuations 
As you add more objects and connections, your canvas may become 
cluttered with connection lines, making it difficult to visualize the 
application. Use a feature called Continuations to reduce the number 
of connection lines on your canvas. 

Continuations involve a parent and a child directly connected, except 
that no connection line between them is visible. You can move the 
child continuation to various locations in the application canvas. A 
parent may have multiple child continuations associated to it. 

Creating a Continuation 
To create a continuation: 

3. To create a continuation parent, right-click on an empty space in 
the canvas and select Insert Continuation Parent (264HFigure 91XX). The 
New Continuation name window appears (X265HFigure 92X). 

 
Figure 91: Insert Continuation Parent 

 
Figure 92: New Continuation Name 

Note: To add a continuation parent, you can also select Insert 
Continuation Parent from the toolbar and drag it to the canvas. 

4. Enter the name and click OK. You can now create the continuation 
child. 

5. Right-click an empty space in the canvas and select Insert 
Continuation Child (266HFigure 93). The Connect Continuation 
window appears listing the available Parents (267HFigure 94). 

 
Figure 93: Insert Continuation Child 
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Figure 94: Insert Continuation Child 

Note: To add a continuation child, you can also select Insert 
Continuation Child from the toolbar and drag it to the canvas. 

6. Select the desired Parent you want to connect and click OK. 

Note: To add a continuation child, you can also right-click the 
continuation parent you want and select Clone. 

 
Figure 95: Inserting a Continuation Child via Cloning 

Displayable Point 
A displayable point is one that appears on the controller’s user 
interface. Once a point is made displayable, the Display plug-in 
includes the point in the list of available points to add to the display. A 

displayable point has the following icon: . 

You can display all points to the device application profile. 
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Making a Point Displayable 
To make a point displayable: 

• In the Application Editor, right-click the point and select Set 
Displayable On ( 268HFigure 96). 

 
Figure 96: Setting Displayable On 

Assemblies 
Assemblies (or Macros) are small sections of application code that you 
save in a separate file (.mcx). You can load predefined assemblies into 
applications, which provide the following benefits:  

• You can reuse code from one application to another. 

Note: You can load an assembly into an application only if it is 
targeted to the same device and firmware version. 

• You can break down your applications into smaller, more 
manageable pieces. Using assemblies makes applications easier 
to create, change, test, and print. 

Creating Assemblies 
To create an assembly: 

1. From the Assembly menu, select New. The Assembly Info window 
appears. 

 
Figure 97: Assembly Info Window 

2. Enter the following information and click OK. 
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• Assembly Name 

• Prepared by (optional) 

• Description (optional) 

An empty Assembly module appears on the Application Editor 
canvas (269HFigure 98). 

 
Figure 98: Newly Added Assembly 

3. Double-click on the new assembly. Once inside the Assembly, you 
use the same techniques described in the following sections: 

• Applying Application Objects 

• Configuring Standard Application Objects 

• Making Connections 

• Adding Inputs, Outputs, and Attributes to the Application 
Editor Canvas 

X270HFigure 99 displays a finished assembly.  

 
Figure 99: Finished Assembly 



 FX Tools Software Package - FX Builder User’s Guide 

 

96 

4. To save the assembly for future use, click Save As from the File 
menu. 

5. Enter the file name and click OK. 

6. Click  to exit the Assembly Application Editor. 

The inputs and outputs of the assembly appear as connectable 
references on the assembly module (271HFigure 100). Now you can 
connect the assembly to other parts of your application (for 
example, to application objects, inputs, or outputs). 

 
Figure 100: Assembly Module 
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Loading Assemblies into an Application 
To load an Assembly into an Application: 

1. From the Assembly menu, select Load (272HFigure 101). 

 
Figure 101: Load Assembly 

2. Select the desired Assembly file and click OK. 

Creating a Distributed Application 
To create a distributed application: 

1. Right-click the device and select New from the Add Slave menu 
( 273HFigure 102X). The New Slave Device window appears  
( 274HFigure 103). 

 
Figure 102: Adding a Slave  

2. Select the target device. A brief description of the device appears 
on the bottom of the New Slave Device window ( X275HFigure 103X). 

Note: For additional information, click the Data Sheet button to 
access a copy of the technical bulletin for the device. 

3. Enter the following information: 

• Name (required) - the name of the slave application 

• Prepared by (optional) 

• Description (optional) 

• Firmware (required) - the firmware version of the targeted 
slave device. This information determines which objects and 
services are available in the application view. 
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Figure 103: New Slave Device Window 

4. Click OK. The slave device object appears on the Control View 
canvas and on the Network view (276HFigure 104). 

 
Figure 104: Slave Device Added to Control View and Network View 

The slave device is automatically assigned a default N2 Address, 
which is identified in the Network view. This address is only 
applicable to slave devices and user interfaces wired to the master 
device’s remote display and local link bus. Do not confuse this address 
with the supervisory N2 address of the master device, as the 
supervisory and local link buses are completely separate trunks. 

Note: If desired, you can change the slave’s N2 address (between 
3 and 255). Click the N2 Address field and enter the new address. 

At this point, you can create and edit the control algorithm for the 
slave device using the Application Editor. 
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FX Builder Plug-ins 
A plug-in is an add-on piece of software that enhances and extends 
FX Builder. 

Application Points Plug-in 
With the application points plug-in, you can do the following: 

• edit application point details 

• configure the default schedules 

• enable events and trends 

Exposing the Application Object References to the Application 
Profile 
Before using the application points plug-in, you must first expose your 
application object references to the application profile (create an 
associated application point). 

To expose an application object reference as an application point in the 
application profile (X277HFigure 105X): 

1. Right-click the object reference, and select the desired application 
point type. 

• Create Volatile Point - if selected, the application point loses 
its value on a power loss. 

• Create Permanent Point - if selected, the application point 
retains its value on a power loss. 

 
Figure 105: Creating an Application Point 

2. Look at the colored arrows on the Control View canvas. 

Once you select the appropriate application point type, the object 
reference appears in the Control View canvas with colored arrows: 

•  = Permanent application point 

•  = Volatile Input application point 

•  = Volatile Output application point 
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Figure 106: Application Points Shown in Control View 

Note: You can also double-click the object reference. The volatile 
application point is automatically created and connected to the object 
reference. This method only creates a volatile point. To change the 
point to a permanent type, use the application point Plug-in. 

Launching the Application Points Plug-in 
To launch the application points plug-in: 

• From the Application menu, select application points  
( X278HFigure 107X). 

 
Figure 107: Launching the Application Points Plug-in 

Note: You can also click the Application Points plug-in 

icon . 
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Using the Application Points Plug-in 
The application points plug-in lists all application points and allows 
you to configure application points, depending on the point type and 
the supported features. See X279HFigure 108X. 

 
Figure 108: Application Points Shown in Control View 

To use the application points plug-in: 

1. In the Data Type column, select the data type from the list. Only 
compatible data types appear. 

2. In the States column, select the desired enumerated point. 

This allows you to define the state name that corresponds to the 
point’s ordinal states. The Type Override window appears  
( X280HFigure 109X). 

 
Figure 109: Editing the State Name for an Enumerated Point 

3. Select one or more state names and click OK. 

4. In the Permanent Storage column, select a check box for 
permanent and clear the check box for volatile. 
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5. If you selected Permanent Storage for a point, then you can enter a 
value for the point. Enter the default value for the point:  

• On/Off Schedule 

• Weekly Schedule 

• Exception Schedule 

For more information, see X281HDefault ScheduleX. 

6. In the Event column, select the check box next to the points you 
want to enable events for. 

7. In the Trend column, select the check box next to the points you 
want to enable trend logging for. 

8. Click OK. 

Default Schedule 
Use the application points plug-in to define the default Weekly 
Occupancy Scheduler, On-Off Time Scheduler, and Exceptions Day 
Calendar. 

You can access the scheduler configuration plug-ins from the 
application points plug-in (282HFigure 110X) in the Value column. 

 
Figure 110: Location of Scheduler Configuration Plug-ins 
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You can configure three types of schedulers in the application points 
plug-in: 

• On/Off Scheduler 

• Weekly Occupancy Scheduler 

• Exception Days Calendar 

Defining the Default On/Off Scheduler 
To define the default On/Off scheduler: 

1. In the application points plug-in, click the icon in the Value 
column. The On/Off Schedule window appears (283HFigure 111). 

 
Figure 111: On/Off Time Scheduler Configuration Plug-in 

2. Drag the On times for each day of the week and the holiday 
(if used). 

Note: The On/Off scheduler only allows 21 events per week, 
regardless if the week is normal or alternate. 
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Defining the Default Weekly Occupancy Scheduler 
To define the default weekly occupancy scheduler: 

1. In the application points plug-in, click the icon in the Value 
column. The Week Occupancy Schedule window appears  
( X284HFigure 112X). 

 
Figure 112: Weekly Occupancy Scheduler Configuration Plug-in 

2. Select the days of the week that have a common occupancy 
schedule. 

3. Click the start time and drag the mouse to the end time for each 
day. 

4. Right-click the highlighted time range and select the desired status 
(Occupied or Standby). 

Note: The Weekly Occupancy Scheduler is limited to five groups 
with five events per group (for normal or alternate week). Each 
change of state (X285HFigure 113X) is considered an event: 

 
Figure 113: Occupancy Scheduler Limitation 
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Defining the Default Exception Days Calendar 
To define the default exception days calendar: 

1. In the application points plug-in, click the icon in the Value 
column. The Exception Day Calendar window appears  
( X286HFigure 114X). 

 
Figure 114: FX Builder Plug-ins to Configure ON-OFF Time Scheduler 

2. Go to the desired month. 

3. Right-click the day you want, and select the desired status 
(Holiday or Alternate). 

FX Simulator 
FX Builder includes an application simulation feature called 
FX Simulator. FX Simulator recreates the same input and output 
behavior of the target hardware device and simulates the application. 

The execution of the application in this environment is called the 
simulation. FX Simulator is application dependent because you can 
simulate the application in runtime before you download it to the 
target controller. 

FX Simulator is also hardware dependent because, depending on the 
selected device, the simulator detects the input/output hardware 
channels. 
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Launching FX Simulator 
To launch FX Simulator, right-click the device block and select 
Simulate Control Logic (287HFigure 115X). 

 
Figure 115: Launching FX Simulator 

FX Simulator Scope 
FX Simulator allows you to simulate and test the following application 
components: 

• device application 

• macro assembly 

Note: In case of a Distributed Application, FX Simulator does not 
simulate the entire application but only one device block at a time. 
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FX Simulator Main Screen  
The FX Simulator (X288HFigure 116X) consists of three sections: 

 
Figure 116: FX Simulator Main Screen 

• Application Window  
Use the Application Window to see the application in its three 
different sub-views: 

− Network view ( X289HFigure 117) 

− Objects view ( X290HFigure 118X) 

− Hardware view ( X291HFigure 119) 

   
Figure 117: Network View Figure 118: Objects View Figure 119: Hardware View 

 

• Watch Window 
Use the Watch Window to add the variables, points, and hardware 
channels to be viewed during simulation. 
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• Graphics Window 
Use the Graphics Window to see a chart that shows the variables, 
points, and hardware channels defined in the Watch Window. 

Simulator Menus – Session Menu 
The Session menu contains the following: 

• New - Starts a new simulation session. 

• Save - Saves the current simulation to a file. 

• Exit - Exits the FX Simulator. 

Simulator Menus – View Menu 
The View menu contains the following: 

• Details Window - shows details of the selected component  
( X292HFigure 120X). 

 
Figure 120: Details Window 

• Logger Window - displays the simulation operations in a 
textual format (X293HFigure 121). 

 
Figure 121: Logger Window 

• Bars - enables or disables the selected toolbars. 
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Simulator Menus – Settings Menu 
The Settings menu contains the following: 

• Simulation speed - allows you to change the simulation speed 
from normal speed to 10 or 100 times faster (X294HFigure 122X). 

 
Figure 122: Set Simulation Speed Rate 

Note: Changing the simulation speed rate affects only the 
application iteration time (typically, one application iteration per 
0.5 seconds). 

• Data logging - allows you to automatically save the data 
logging to a file (X295HFigure 123X). 

 
Figure 123: Set Automatic Data Logging 

• Units of Measure - allows you to select the desired units of 
measure (SI [°C] or US [°F]) displayed in the simulator session 
( X296HFigure 124X). 

 
Figure 124: Units of Measure Setting 
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Simulator Menus – Processor View 
The Processor menu contains the following: 

• Run - Starts the simulation. 

• Stop - Stops the simulation. 

• Step - Runs a step-by-step simulation. 

Simulator Main Toolbar 
The Main Toolbar offers you shortcuts to most common commands 
( X297HFigure 125X). 

 
Figure 125: Simulator Toolbar 

X298HTable 19X describes the buttons in the toolbar. 

Table 19: Simulator Toolbar 
Icon Description 

 
Create a new Simulator session. 

 
Save the Simulator session. 

 
Start the simulation. 

 
Run a step-by-step simulation. 

 
Add a new sheet to the Watch Window. 

 
Rename the selected sheet in the Watch Window. 

 
Remove the selected sheet from the Watch Window. 

 

Adding Network Variables from the Application Window to the 
Watch Window 
To add a network variable from the Application Window to the Watch 
Window: 

For Network Variable Outputs (NVOs): 
In the FX Simulator main screen, right-click the desired variable and 
select Add Item to Watch. 

Note: You can also drag the variable from the Application Window 
to the Watch Window. 
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For Network Variable Inputs (NVIs) or Configuration 
Property (CP): 
1. In the FX Simulator main screen, right-click the desired variable 

and select Set Value and Add Watch. The Edit Value window 
appears (X299HFigure 126X). 

 
Figure 126: Adding an NVI to the Watch Window 

 
Figure 127: Edit Value Window 

2. Enter the values of the NVI or CP to use only during the 
simulation. 

Adding an Object Point from the Application Window to the 
Watch Window 
To add an object point from the Application Window to the Watch 
Window, right-click the desired object output and select Add Item to 
Watch. 

 
Figure 128: Adding an Object Point to the Watch Window 
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Note: You can also drag the point to the Watch Window. 

Note: You can only add the Object Outputs to the Watch Window 
because the Object Outputs represent the Outputs (read value) 
generated by the application algorithm running in the FX controller. 

Adding Hardware Channels from the Application Window to the 
Watch Window 
Viewing hardware channels during simulation allows you to recreate 
the same input and output behavior of the FX controller. Depending on 
the type of the hardware channels, you can force or watch the status of 
the hardware inputs and outputs of the FX controller. For example, 
you can directly force a voltage value on a 0-10 V analog input. 

To add hardware channels from the Application Window to the Watch 
Window: 

For hardware outputs: 

• Right-click the desired channel and select Add Item to Watch 
( X300HFigure 129X). 

 
Figure 129: Adding an Output to the Watch Window 

Note: You can also drag the variable from the Application 
Window to the Watch Window. 

For hardware inputs: 
1. Right-click the desired channel and select Set Value and Add 

Watch ( X301HFigure 130X). The Edit Value window appears (X302HFigure 131X). 

 
Figure 130: Set Value on a HW Channel 
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Figure 131: Edit Value 

2. Enter a value to use on the input channel only during the 
simulation. 

Simulation Example 
In X303HFigure 129X, a PID control loop has been defined in the application 
and includes a 4-20 mA Analog Input and a 0-10 V Analog Output. 
The variables/HW channels under watch are as follows: 

• Analog Input1 

• Analog Output1 

• nciPID_SetPt 

• nciPID_PropBand 

• nciPID_IntTime 

 
Figure 132: Variables/Object Outputs/HW Channels on Watch Window 
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Starting a Simulation 
Once you define the network variables, object points, and hardware 
channels that compose the simulation, you can start the simulation. 

When you start the simulation, the first four points defined in the 
Watch Window automatically populate in the Graphics Window 
( 304HFigure 133X). 

 
Figure 133: Graphics Window 

On the Y axis, the simulator projects the current value of the points 
defined in the Watch Window. On the X axis, the simulator projects 
the application iteration/loop time. 

Address Book Manager 
The Address Book Manager stores contacts or groups of contacts used 
for the controller notification services (X305HFigure 134X). 

Note: This feature applies only to controllers that support 
notification services. 

When you create a new contact, you can include one of the following: 

• Mobile Phone Number - used by the controller as destination for 
SMS Notification Services. 

• E-Mail Address - used by the controller as destination for e-mail 
notification services. 
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Figure 134: Address Book Manager 

Note: You use contact information only for supported services. For 
example, if only you use SMS notification, then only the mobile 
number is required. The same is valid for contacts that have only the 
e-mail address defined. 

When you create a New Group of contacts, you first define the group 
and then copy or move the already defined contacts into the desired 
group. 

The Address Book Manager allows you to perform the following 
commands: 

• Move to Group - removes the contact from the Single Contacts 
list and adds it into the desired group. 

• Copy to Group - adds the selected contact into the desired 
group, leaving it also in the Single Contacts list. This feature is 
useful because the grouped contacts cannot be used as single 
contacts. 

Move and Copy commands are available also to copy or move 
contacts from a Group to the Single Contacts list. 

• Rename - allows you to rename a contact. This function is 
available for Contacts only by right-clicking on the Contact. 
Groups cannot be renamed. 

• Delete - removes the selected element from the address book. 

• Import - allows you to load and use an already-built Address 
Book (.xml). 

• Export - allows you to save an Address Book (.xml) file for 
future use. 
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Events 

The Events plug-in allows you to configure the events of the 
application and their corresponding Messaging Service actions 
(notifications). The Events Menu Item  opens the Events plug-in 
( X306HFigure 135X). 

 
Figure 135: Events Plug-in 

Grayed columns indicate that the related Messaging Service is not 
available; this is because contacts are not available in the address book 
with the needed information to execute the related Messaging Service. 
For example, for SMS Messaging Service, the mobile phone number of 
the contact is required. 

You can define events on binary (Boolean) or logic (enumerated) 
variables coming from the application points profile. 

System Events 
Another group of events are defined as the System Events Group and 
consist of predefined event conditions related to the proper execution 
of the application. System events include: 

• Powerup - triggered when FX controllers turn on. 

• Field Device - triggered when field (slave) devices do not work 
properly (available only for master devices). 

• Application Error - triggered when applications (.apd) become 
corrupt (available only for master devices). 

• Local Display Application Error - triggered when display 
applications become corrupt (available only for master devices). 
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• Bad Field Device Configuration Error - triggered when a slave 
is not found at the predefined N2 address (available only for 
master devices). 

• Event Full - triggered when Buffer Full threshold (user settable) is 
reached (available only for master devices). 

• Trend Auto-Erase - triggered when the data trend buffer is full, 
and the controller is configured to automatically erase the buffer. 

• Event Auto-Erase - triggered when the event buffer is full, and 
the controller is configured to automatically erase the buffer 
(available only for master devices). 

• Communication Failure - triggered if the controller fails to send 
notifications (SMS or e-mail). 

Events – Notify Way 
If more than one notification type (e-mail and SMS) is sent for the 
triggered event, you can prioritize which media to use first 
( X307HFigure 136X). The notification options include: 

• Broadcast - Sends both e-mail and SMS notifications. 

• Prioritized - Select which media to use first. In case the 
primary method fails, you can use a secondary media as a 
backup. 

 
Figure 136: Notify Way Set to Broadcast and Prioritized 
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Event Definitions 
When you create an event, you define the following (X308HFigure 137X): 
• Event User Name - Enter the name that appears on the user 

interface and Web page. 

• Send UI - Select whether to send the event to the User Interface 
(UI). 

• UI ACK - Select if acknowledgement is required. 

• Priority Management - Select whether to broadcast or 
prioritize notification (only available for master devices). 

• Triggering Condition - Select which event state triggers 
notification. 

• Event Status User Name - Enter the Event Status name that 
appears. 

• Event Message - Enter the message that is sent to SMS or 
e-mail. 

• Select and Configure the Notification Services - Select the 
desired contact or group already defined in the address book. 

 
Figure 137: Configuring the Notification Services 
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Customizing the Notification Service 
To customize the notification service: 

1. In the Events window, right-click the contact and select Edit 
Notification. The Notification window appears (X309HFigure 138X). 

 

Figure 138: Editing the Treatment 

2. Edit the notification message related to the selected event. 

The event notification message is an alphanumeric string that can 
contain tagged elements. The tags report in the string the assigned 
value at the moment of the notification. For example, the @TIME 
tag is replaced by the current time value. 

The available tagged information is as follows: 
• @LOCATION of the Controller  

(for example, @LOCATION = Meeting Room 1st Floor) 

• @NAME of the Event  
(for example, @NAME = Low Pressure Switch) 

• @DATE of the Event  
(for example, @DATE = 31 Oct 2005) 

• @TIME of the Event  
(for example, @TIME = 12.15) 

3. Choose the destinations between the available contacts or groups 
already defined in the address book. 

The available contacts and groups defined in the address book 
appear, allowing you to select the preferred destination for the 
selected event. The final destination must be unique. To send 
notification to more than one contact, define a group within the 
address book containing all the contacts you want to send a 
notification to at the same time. 

4. Click OK. 
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Event Maker Limits 
The maximum number of collectable events depends on the specific 
FX field controller. X310HTable 20X summarizes the current limit for each 
device: 

Table 20: Event Maker Limits 
Controller Limitation 
MD20 Master 
Display 

Maximum 20 events 

FX16 Master 
Controller 

Non revision A: maximum 20 events 
Rev. A and B: maximum 250 events 

FX15 and FX15 
Universal  

Maximum 12 events 

FX14 Maximum 20 events 
FX10 Maximum 10 events 
FX06 and FX07 Maximum 20 events 
FX05 
(Advanced) 

Maximum 16 events 

 

Trends 
The Trends plug-in allows you to configure the trend logs of the 
application. 
Note: Not all FX Controllers support trending. Check the 
appropriate technical bulletin of the target controller to ensure this 
feature is supported. 

Before you configure trends, you must first select the variables for 
trending in the application points plug-in. Click on the Trends Menu 
Item  to open the Trends plug-in. 

The Trend plug-in contains two tabs windows to set up the trend: 
Configuration and Services. 

Configuration Tab 
On the Configuration tab, you define the following information: 

• User Name - enter the name of the trend that appears on the 
user interface and the Web. 

• Trend Mode - select between Periodic sampling or On 
change of value reporting (depends on trend type). 

• Sample Period - if Periodic sampling mode was selected, 
enter the sample period, in minutes. 

• Trend Start and Stop Conditions - use for logic or 
enumerated variables only. 
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Figure 139: Configuration Tab of the Trends Plug-in 

Services Tab 
The Services tab contains several sections including (311HFigure 140X): 

• Buffer management 

• Periodic offload management 

• Notification priority 

 
Figure 140: Services Tab of the Trends Plug-in 
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Buffer Management 
The Trends plug-in provides several options to deal with a full trend 
buffer. 

You can enable circular buffering to replace the oldest trend records 
with new ones without any notification. If circular buffering is 
disabled, you can define a Buffer Full event with corresponding 
notification services. 

In configuring the Buffer Full Event, you define the following: 

• Percentage - the trend buffer full percentage that triggers the 
event 

• End Mode - the action to take when trend buffer full percentage 
is reached. You can set the End Mode to Stop recording or 
Erase and continue. 

Buffer Management - Stop Recording 
At the defined percentage, the controller notifies the user via the 
specified media that the memory full threshold has been reached. The 
controller then continues recording data until the buffer full condition 
is reached; at this point, the recording stops. 

Buffer Management - Erase and Continue 
At the defined percentage, the controller notifies the user via the 
specified media that the memory full threshold has been reached. The 
controller then continues recording data up to the memory full 
condition. Once the memory full condition is reached, the controller 
(before erasing the buffer) automatically sends an e-mail with the trend 
records since the last offload and saves the last 60 events in a backup 
memory. The controller then erases the flash memory buffer, copies 
the 60 saved events, and restarts logging. 

Note: During the last e-mail (for the entire length of the 
connection) and during the successive memory erase, the logging of 
new events and data is inhibited. 

Buffer management contains the following functions: 

• Notification Mode - Selects Broadcast (sends both SMS and 
e-mail notification) or Prioritized (sends to primary method 
first, then to secondary if primary fails). 

• Notification Ways - Identifies the contact to receive the 
notification. 
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Buffer Management - Periodic Off Load 
The Trends plug-in allows you to enable or disable periodic offloading 
of trend records via e-mail using Space Separated Value format 
( X312HFigure 141). 

SpaceTemp 

22/10/2006 09:42:31   77.790 

22/10/2006 09:42:32   77.780 

22/10/2006 09:42:33   77.790 

22/10/2006 09:42:34   77.790 

22/10/2006 09:42:35   77.780 

22/10/2006 09:42:36   77.780 

22/10/2006 09:42:37   77.780 

Figure 141: Trended Value via E-mail 

When you configure the Periodic Offloading, you define the following 
information: 

• Offload Period - Defines the frequency of the notifications (can 
be adjusted between 0 - 24 hours). 

• Headline String - Defines the subject for the e-mail 
notification. 

• Notification Mode - Sets the mode to Broadcast or Prioritized. 

• Notification Ways - Defines the contact to receive the e-mail. 

Display 
Use the Display plug-in to define and format the controller’s user 
interface. 

X313HTable 21X displays user interface compatibility information. 

Table 21: Display 
Display Type Description Supported Controller 
INT7S Three 7-segment LEDs with 

four push buttons, and three 
discrete LEDs 

Integrated into FX05 

LCD2x4 2 line x 4 character Liquid 
Crystal Display (LCD) with 
four push buttons, dynamic 
colored backlight, and 
graphical status icons 

Integrated into FX06 and 
FX14 (option) 

Continued on next page . . . 
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Display Type 
(Cont.) 

Description Supported Controller 

MUI 4 line x 20 character backlit 
LCD, six push buttons, and 
10 discrete status LEDs 
 

FX06 (remote) 
FX14 (remote) 
FX15 (integrated or remote) 
FX16 (remote) 

MUI_V3 4 line x 26 character backlit 
LCD, six push buttons, and 
10 discrete status LEDs 
 

FX06 (remote) 
FX14 (remote) 
FX15 (remote) 
FX16 (integrated [Rev. A or 
Rev. B only] or remote) 

GUI 240 x 148 pixel graphical 
LCD, 10 push buttons, and 3 
discrete status LEDs 

Integrated into MD20 

 

Launching the Display Plug-in 
The Display plug-in consists of a menu bar, a list of configuration 
categories, a details panel, and a configuration panel (X314HFigure 142X). 

 
Figure 142: FX Builder Display Plug-in 

To launch the Display plug-in, right-click the  icon and select the 
target display (depending on the controller). The Display plug-in 
appears (X315HFigure 143X). 

Menu Bar 

Categories 

Menu Bar 

Configuration 
Panel 
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Figure 143: Launching Display Plug-in 

Menu Bar Details 
The File menu of the Display plug-in menu bar includes: 

• Load Template 

• Save Template 

The Tools menu of the Display plug-in menu bar includes the 
following: 

• Statistic Info - allows you to check the memory usage allocated 
for the display configuration (X316HFigure 144X). 

 
Figure 144: Statistic Info 

Configuration Categories 
The Display Plug-in features the following configuration categories: 

• Layout - allows you to configure how information is organized 
and appears on the display. 

• Buttons - allows you to assign actions to the push buttons. 
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• LEDs - allows you to assign discrete status information to each 
of the LEDs. 

• User Accounts - allows you to define the user name, password, 
and access rights for each user account. 

• Events - allows you to define which events are displayed and 
the allowed actions. 

• Schedulers - allows you to define the interface to the schedules 
configured in the application. 

• Trends - allows you to define which events are displayed and 
the allowed actions. 

• Languages - allows you to set the language of select System 
Texts and User Texts. 

Configuring the Menu Based Navigation 
The LCD2x4 and Medium User Interface (MUI) user interfaces 
provides menu-based navigation. Each user interface includes a default 
Home folder and Home Page. Other default folders and pages include 
events, trends, and schedulers, depending on the capabilities of user 
interface type you added to the application. In addition, you can define 
customized folders and pages to provide operator access to application 
points and system information. You can link the default and 
user-defined pages and folders to a menu for the operator to easily 
access. Each folder and page has display attributes, which determine 
how they appear and are accessed in the user interface. 

Adding and Configuring a User Account 
The LCD2x4 and MUI user interfaces allow you to restrict operator 
access to information based on user account and the defined access 
level. 

To add and configure a user account: 

1. Click User Accounts. The Details Panel shows a list of all defined 
User Accounts. 

2. Click on Account and select Add Account (X317HFigure 145X). 

 
Figure 145: Adding a User Account 

The Configuration Panel appears showing the following 
configurable user account attributes:  

• User Name - allows you define the user name text as it appears 
in the display. 
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• Password - allows you to define the password for the selected 
user account. 

• Level - allows you to define the access level for the selected 
user accounts. 

Adding Folders and Pages 
To add additional folders and pages: 

1. Select the Layout tab. A Layout tree appears in the Details Panel 
and identifies the display folders and pages. 

2. Right-click on Layout and select Add Folder (318HFigure 146). 

 
Figure 146: Adding a New Folder 

3. Enter the name of the folder and click OK. The Layout tree is 
populated with the new folder and an associated page (X319HFigure 147). 

 
Figure 147: New Display Folder Added 
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After you add a display folder, you can right-click on it and select 
from the following actions: 

• Add a page 

• Copy 

• Delete 

• Rename 

Note: You cannot add additional pages to the INT7S and LCD2x4 
user interfaces. Both user interfaces only support one page per folder. 

 
Figure 148: Folder Actions 

Editing Display Folder Attributes 
When you select the display folder, the Configuration Panel appears 
and allows you to define the following display attributes for the 
selected folder: 

• Associate to menu - when this box is checked, the display 
folder appears in the main menu. 

• Menu name - allows you to define how the folder name appears 
in the main menu. 

• Account level - allows you to identify the user access level 
required for the selected display folder. 

• Enabling Condition - allows you to identify a special condition 
to enable the display folder (see X320HDefining ConditionsX). 

• Inactive buttons - allows you to select which buttons are 
inactive when the operator is using this display folder. 
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Figure 149: Editing a Display Folder’s Attributes 

Editing Display Page Attributes 
When you select a display page, the Configuration Panel populates 
with a What You See Is What You Get (WYSIWYG) display page 
editor and the following configurable page attributes: 

• Entry State - allows you to set the page entry state to Idle or 
Active. The Idle state requires operators to push the Enter 
button before they can edit a point. The Active state allows 
operators to edit a point immediately after they open the display 
page. 

• Timeout - allows you to define the operator inactivity time 
before the user interface automatically reverts to the home page. 

Defining Conditions 
You can enable or disable a display folder depending on certain 
conditions. The Conditions tab allows you to define a folder’s enabling 
conditions. 

To define a condition: 

1. Select the Conditions tab. A list of enabling conditions appears. 

2. Right-click Enabling Conditions and select Add Enabling 
Conditions (321HFigure 150). 

 
Figure 150: Adding an Enabling Condition 

The Select Source window appears and shows a list of all 
permanent points defined in the application. 
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Figure 151: Adding an Enabling Condition 

3. Select the desired application point to act as the source of the 
enabling condition and click OK. 

The Configuration Panel appears and shows the newly added 
enabling condition (the source point) and the available states. 

4. Check all states to enable the display folder. 

5. Go into the Layout tree, select the folder, and edit the folder 
attributes to identify the enabling condition. For more information, 
see X322HEditing Display Folder AttributesX. 
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Adding Application Points to a Display Page 
To add an application point to a display page: 

1. Select the desired page in the Layout tree. The Configuration pane 
provides a display page editor (X323HFigure 152). 

 
Figure 152: Display Page Editor 

2. Position your cursor to where you want to insert the application 
point. 

3. Right-click the area and select Application Points (X324HFigure 153X). 

 
Figure 153: Inserting Application Points on a Display Page 

A Select Points window appears and provides a list of all 
application points and displayable points defined in the 
application. Check the boxes for the points you wish to add to the 
display page. 
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Figure 154: Adding an Enabling Condition 

4. Click OK. The Display Page Editor reappears and displays the 
application points you selected. 

5. To change how the application point information appears on the 
display page, double-click the application point. The Edit Numeric 
Point (X325HFigure 155X) or Edit Enumerated Point (X326HFigure 156X) window 
appears and allows you to configure the following display point 
attributes: 

• Point Name - allows you to define the text used to display the 
point name. 

• Account Level - allows you to define the user access level 
required to view and edit the selected point. 

• Read Only - allows you to restrict operator access to read-only 
(write not allowed). 

• Show Invalid - allows you to define the point value when 
invalid. 

• Invalid Label - used in conjunction with Show Invalid to 
allow you to define the point value when invalid. 

• Data size - allows you to define the total number of characters 
to be displayed for the selected point’s value. 

• Number of decimals - allows you to define the number of 
decimal places to be displayed for the selected point’s value. 

• Unit of measure - allows you to define the units of measure 
for the selected point’s value. 
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• Unit of measure symbol - allows you to define the unit of 
measure symbol for the selected unit of measure. 

• Validity range - allows you to limit editing to within the 
specified range. 

• Is Selected - allows you to remove or include specific 
enumerated point states from the display. 

• Displayed states text - allows you to define the text displayed 
for each enumerated point state. 

 
Figure 155: Edit Numeric Point 

 
Figure 156: Edit Enumerated 
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6. To optimally fit the application point name, value, and units of 
measure within the available display page row, select the 
application point, right-click, and select Fit. 

Adding Text to a Display Page 
To add text to a display page: 

1. Select the desired page in the Layout tree. The display page editor 
appears in the Configuration Panel. 

2. Position your cursor where you want to insert the text. 

3. Right-click the area and select Text (X327HFigure 157). The Edit Point 
window appears and prompts you to enter the desired text  
( X328HFigure 158X). 

 
Figure 157: Inserting Text on a Display Page 

 
Figure 158: Edit Point Text Window 

4. Click OK. The display page editor reappears with the added text. 

5. To change the position of the text on the display page, select the 
text and drag it to the desired location. 
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Adding System Information to a Display Page 
In addition to adding application points and text to a display page, you 
can also add various pieces of system information to a display page. 
The types of system information you can add depends on the type of 
user interface you select. This may include any of the following: 

• time 

• date 

• date format 

• unit of measure 

IMPORTANT:  The unit of measure setting affects not only the values of 
points shown on the display, but also the values of points transmitted on 
the N2 or BACnet network. If you plan to install the target controller on an 
N2 or BACnet network, you must add the unit of measure selector with the 
appropriate default setting in the display configuration, regardless of 
whether a display is actually used. 

• language (see X329HAdding Multiple Language SupportX) 

• address (LCD2x4 only) 

• LCD contrast (LCD2x4 only) 

• backlight time (LCD2x4 only) 

• default color (LCD2x4 only) 

• alarm color (LCD2x4 only) 

• baud rate (LCD2x4 only) 

To add system information to a display page: 

1. Select the desired page in the Layout tree. The display page editor 
appears in the Configuration Panel. 

2. Position your cursor where you want to insert the system 
information. 

3. Right-click in the area, select System Point, and then select the 
desired system information (330HFigure 159X). 

 
Figure 159: Inserting System Information on a Display Page 
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Push Button Management 
Each user interface type features a unique set of push buttons and 
default system capabilities (X331HTable 22X). In addition, you can assign 
user-defined functions to each push button (or to multiple push 
buttons). 

Table 22: User Interface Push Buttons 
User Interface Type Push Buttons 
INT7S 4 push buttons (Up, Down, Function, Enter) 
MUI_V2 and MUI_V3 6 push buttons (Up, Down, Left, Right, Enter, 

Escape) 
LCD2x4 4 push buttons (Up, Down, OK, Cancel) 
GUI 10 push buttons (Up, Down, Left, Right, Enter, 

Escape, On/Off, Menu, Alarm, Alarm Ack 
[Acknowledge]) 

 

Assigning User-Defined Functions to Push Buttons 
To assign a user-defined function to a push button: 

1. Select Buttons. The Details Pane displays the available push 
buttons for the target user interface (X332HFigure 160X and X333HFigure 161X). 

 
Figure 160: Available Buttons for LCD2x4 
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Figure 161: Available Buttons for MUI 

2. To assign a function to more that one push button, right-click 
Buttons and select Add Multiple Button (X334HFigure 162X). The Select 
Buttons to Associate window appears ( X335HFigure 163X). 

 
Figure 162: Adding a Multiple Button 

 
Figure 163: Select Buttons to Associate 

3. Select the buttons you want to combine to associate a function and 
click OK. The multiple buttons appear in the Buttons tree  
( 336HFigure 164). 
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Figure 164: Add Multiple Button 

4. Select the button or multiple buttons to assign a function. 

The Configuration Panel allows you to assign functions to the 
selected button. The functions occur either when the button is 
pressed or released. You can configure the following task attributes 
for the selected button (or multiple buttons): 

• Task - allows you to define the specific function assigned to 
the selected button (X337HTable 23X and X338HFigure 162X). 

Table 23: User Interface Push Buttons 
Task Description Applies to 
Set Commands a 1 to the target 

control point. 
MUI_V2, MUI_V3, INT7S, 
LCD2x4, GUI 

Clear Commands a 0 to the target 
control point. 

MUI_V2, MUI_V3, INT7S, 
LCD2x4, GUI 

Toggle Toggles command between 0 
and 1 to the target control 
point. 

MUI_V2, MUI_V3, INT7S, 
LCD2x4, GUI 

Shortcut To Jumps the operator to the 
target page. 

MUI_V2, MUI_V3, INT7S, 
LCD2x4, GUI 

Alarm ACK Acknowledges alarm. MUI_V2, MUI_V3 
Log OFF Logs off. MUI_V2, MUI_V3, LCD2x4, 

GUI 
Keyboard Lock Locks out the keypad. INT7S, LCD2x4 
Self Test Performs self test. INT7S 
Service Pin Sends a Service Pin 

message to LON network. 
INT7S, LCD2x4, GUI 
 

Menu Jumps to the Main Menu. GUI 
Buzzer Off Turns the buzzer off. GUI 

 

• Validation Time - allows you to define the amount of time a 
user must press the button must before the associated task is 
performed. 
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• Target - identifies the control point for the Set, Clear, or 
Toggle task. Identifies the page for the Shortcut To task. 

• Autorepeat - if selected, the push button automatically repeats 
its assigned function when continuously pressed. This feature 
uses the up and down arrows as a default to improve operator 
usability when editing values at the user interface. 

You can also assign password protection to a push button 
function (except for Log OFF and Alarm ACK). When a push 
button function is password protected, the user must have the 
requested password level or higher; otherwise an Access 
Denied message appears. 

 
Figure 165: Configuring the Push Button Function 
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Adding LED Association 
You can associate specific events and application point status to the 
discrete LEDs (MUI) or status icons (LCD2x6) on the target user 
interface. This provides the operator with a quick visualization of 
specific events and point status. 

To add an LED association: 

1. Select Leds. The Details Panel lists the available LEDs specific to 
each user interface type (X339HFigure 166X and X340HFigure 167X). 

 
Figure 166: LEDs for MUI 

 
Figure 167: Status Icons for LCD2x4 

2. Select the LED to which you want to associate a status. 

The Configuration Panel displays a picture that shows the selected 
LED or status icon and allows you to define the blinking condition 
( X341HFigure 168X). 

 

 
Figure 168: LED Configuration Panel 
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3. To select the LED association source, click Browse and select the 
control point from the list. (X342HFigure 169X). 

The Configuration Panel then allows you to configure the 
operation of the LED. You can configure the LED to be On, Off, 
or blink (fast or slow) according to the different states of the source 
point. 

 
Figure 169: Configuring Blinking Modes 

Configuring Event Display Attributes 
You can configure the user interface to display system events (for 
example, communication failure or trend buffer full) and any 
application events you have defined. The display plug-in allows you to 
define the display attribute for each event (for example, how events 
appear on the user interface). 

To configure event display attributes: 

1. Select Events. The Configuration Panel prompts you to define how 
the system events and application events appear on the display 
( X343HFigure 170X). 

 
Figure 170: Configuring Event Display Attributes 

2. Edit the attributes in the top section of the Configuration Panel. 

The top section of the Configuration Panel displays a list of 
available system events and the following configurable display 
attributes: 

• Displayed Name - allows you to define the event name text as 
it appears in the display. 
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• Display Mode - allows you to define the event’s appearance in 
the display. When an event occurs, you can configure the user 
interface to display the Event Name only, the State Name only, 
or the Event and State Name. 

• Summary Priority - allows you to define the event’s 
organization in the Event Summary log. You can set the 
Summary Priority to High, Intermediate, or Low. 

Note: Set the Summary Priority to High (3) to activate the 
buzzer in the display. 

• Ack Password Level - allows you to define the user access 
level required to acknowledge alarms (MUI only). 

3. Edit the attributes in the bottom section of the Configuration Panel. 

The bottom section of the Configuration Panel displays a detailed 
table that lists the states for each selected event. You can change 
the displayed states text for each event. 
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Configuring Scheduler Display Attributes 
You can configure the user interface to allow users to view and adjust 
schedules defined in the application. The display plug-in allows you to 
define each scheduler display attributes (for example, how the 
schedules are viewed and edited on the user interface). 

To configure scheduler display attributes: 

1. Click Schedulers. The Configuration Panel lists each scheduler 
defined in the application (344HFigure 171X). 

2. Edit the following configurable display attributes: 

• Show - allows you to show or hide the scheduler. 

• Displayed Name - allows you to define the scheduler name as 
it appears on the display. 

• Edit Account Level - allows you to define the user access 
level required to edit the schedule start and stop times. 

• View Account Level - allows you to define the user access 
level required to view the schedule. 

 
Figure 171: Configuring Schedulers Display Attributes 

Adding Multiple Language Support 
Certain controllers support up to five different languages that you can 
choose via the user interface at runtime. 

Note: Check the technical bulletin of the target controller to 
determine if multiple language capability is supported. 

The Display plug-in allows you to develop the main display 
application in the chosen primary language. You can then identify 
translations for the dates, states text, and point names used in the 
display configuration. The translation must not exceed the maximum 
string length. 

To add multiple language support: 

1. Select the Languages category. A list of Language translations 
appears in the Details Panel. The default language is lang0. 

2. To add a language translation, right-click on Language and select 
Add Language. The Add New Language window appears  
( 345HFigure 172X). 
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Figure 172: Adding a New Language 

3. In the Available Language list, select English or Other. If you 
select Other, you can define the language translation name in the 
Description field. 

4. Click OK. If you want more languages translations, repeat 
Steps 2-3. The Configuration Panel displays the default language 
and all language translations that you added (346HFigure 173X). 

You can define translations for every piece of displayable text 
defined in the display configuration. 

 
Figure 173: Language Configuration Panel 

Saving the User Interface Configuration 
To save the user interface configuration, click OK. 

Web Site  
The Web Site plug-in allows you to develop the Web pages served up 
by the controller. 

Note: Not all controllers support the Web Site feature. Refer to the 
technical bulletin of the target controller to determine if this feature is 
supported (347HTable 24X). 
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Table 24: FX Controller Technical Bulletins 
Technical Bulletin LIT Number 
FX05 (Advanced) Field Controller Technical Bulletin LIT-12011155 
FX06 Field Controller Technical Bulletin LIT-12011166 
FX07 Field Controller Technical Bulletin LIT-12011269 
FX14 Field Controller Technical Bulletin LIT-12011164 
FX15 Field Controller Technical Bulletin LIT-12011107 
FX16 Master Controller Technical Bulletin LIT-12011108 

 

The navigation of the Web site is stored in the controller configuration, 
and you can restrict it with several levels of passwords to different 
users. 

Toolbar 
The toolbar (X348HFigure 174X) includes commands to edit the Web Site, 
including: 

• Cut 

• Copy 

• Paste 

• Shortcut to Site Map 

• Text attributes (left/center/right justification, bold, italics, 
underline) 

• Link to Home Page 

• Refresh 

• Edit Enumerated Texts 

.  

Figure 174: Toolbar 

Adding Content to the Web Site 
To add content to the Web Site: 

1. Right-click the Web Site Root in the Site Tree and select Add. 
Choose from the following: 

• Page 

• Protected Folder (adds a password protected folder) 

• Events Pages 

• Trend Logs Page 

• Schedulers 



 FX Tools Software Package - FX Builder User’s Guide 

 

146 

 
Figure 175: Adding Content to Web Site 

Adding a Web Page 
The Web page you add allows you to add and format text, hyperlinks, 
tables, and application points (including volatile inputs and outputs and 
permanent points). 

To add a Web page: 

1. Right-click the Web Site Root in the Site Tree and select Add and 
then select Page. The Add Page window appears (X349HFigure 176X). 

 
Figure 176: Adding Content to Web Site 

2. Enter the page name and title and click OK. The Edit Page window 
appears (X350HFigure 177X). 



 FX Tools Software Package - FX Builder User’s Guide 

  

147

 
Figure 177: Edit Page Window 

Tabs at the bottom of the Edit Page window allow you to preview the 
Web page and to jump back to the site map. 

Web Site Text 
When adding text to a page (351HFigure 178X), the plug-in provides 
commonly used text editing features, including: 

• alignment 

• text properties 

• default header properties 

  

Figure 178: Editing Text 
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Web Site Tables 
When adding or editing a table, the plug-in provides commonly used 
table formatting features such as alignment, spacing, borders, and 
padding (X352HFigure 179X). 

Once the table is added and formatted, you can insert text, hyperlinks, 
and application points into the table’s cells. 

 
 

Figure 179: Adding Tables 

Adding Hyperlinks 
Hyperlinks provide you with the ability to jump to any of the available 
pages (X353HFigure 180X). 

To add a hyperlink: 

• Right-click in the Web page and select Hyperlink and then 
select the page to link to. 

You can link to any page already predefined (including normal 
pages, the home page, the events page, the schedule page, and the 
trends page). 

 
Figure 180: Adding a Hyperlink 
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Adding Application Points 
To add application points: 

1. Right-click the Web page and select the desired volatile input, 
output, or permanent point (X354HFigure 181X). 

 
Figure 181: Adding an Application Point to a Web Page 

Note: You can also select one or more application points from 
the Display and Application View window (355HFigure 182X). 

  
Figure 182: Adding Application Points from Display and Application 

View 

Multiple application point selection automatically creates a 
corresponding table with these default fields: 

• Variable - the name of the application point. You can edit this 
name in the table, if desired. 

• Value - the value of the application point 

• Unit - the units of measure symbol 

2. Edit the table as desired (X356HFigure 183X). 
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Figure 183: Inserting a Table from the Display View 

Editing Application Points in a Page 
You can edit an application point in a Web page by right-clicking on 
its value (X357HFigure 184X) and selecting one of the following: 

• Details - allows you to visualize the point details. 

• Delete - removes the point entirely from the page. 

• Absolute - removes the point from the table to be positioned 
elsewhere on the page. 

 
Figure 184: Editing an Application Point 

Adding Users and Restricting Access 
You can restrict access to certain data by setting up protected folders 
and defining authorized users and their corresponding passwords. 

To add users and restrict access: 

1. Right-click Authorizations and select Add ( 358HFigure 185X). The Add 
Authorization window appears (X359HFigure 186X). 



 FX Tools Software Package - FX Builder User’s Guide 

  

151

 
Figure 185: Adding a User 

 
Figure 186: Adding Login Name and Password 

2. Enter a LogIn Name and Password (fewer than 15 characters). 

3. Repeat Steps 1 and 2 until you add all authorized users. The users 
appear in the Authorizations list in the Site Tree ( X360HFigure 187X). 

 
Figure 187: Authorized Users in Site Tree 
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4. Right-click Web Site and select Protected Folder from the Add 
Menu (X361HFigure 188). The Add Folder window appears (X362HFigure 189X). 

 
Figure 188: Adding a Protected Folder 

 
Figure 189: Adding Folder Authorizations 

5. Enter the folder name and identify the users authorized to access 
the pages in this folder. 

6. Click OK. 

Once added, the Protected Folder appears in the Site Tree with a 
folder and lock icon  ( X363HFigure 190X). 

 
Figure 190: Protected Folder Added 

7. To add a page to the protected folder, right-click the locked folder 
and select Add Page (364HFigure 191X). You can now edit the page as a 
normal page. 
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Figure 191: Adding a Protected Page 

Adding the Events Pages 
To add Events Pages: 

1. Right-click Web Site and select Events Pages from the Add menu. 
The Events folder appears in the Site Tree (X365HFigure 192 X). 

 
Figure 192: Adding Events Pages 

 
Figure 193: Adding Events Pages 

Two default pages are automatically created. These pages collect 
and display the events identified in the application points plug-in 
and configured in the Events plug-in. You cannot edit these Events 
pages. 

2. In the Site Tree, select current_events.html to view the Current 
Events Page ( 366HFigure 194X). This page can collect up to 20 active 
events. 
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Figure 194: Current Events Page 

3. In the Site Tree, select events_log.html to view the Events Log 
Page. This page provides you with filter options like Application 
Events or System Events. 

 
Figure 195: Events Log Page 

Adding Trend Pages 
To add a trend page: 

• Right-click the Web site root and select Add and then Trends 
Log Page ( X367HFigure 196X). A default Trend Logs Page is 
automatically created and added to the Site Tree. 

 
Figure 196: Adding the Trend Logs Page 
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The Trends Log Page collects and displays all the trended 
variables identified in the application points plug-in and 
configured in the Trends plug-in. The Trend Logs page is not 
editable. 

 
Figure 197: Trend Logs Page 

Importing Trended Data into Microsoft Excel 
Once the trended variable has been logged, you can access the trended 
data in two different ways: 

• Wait for a periodic offload notification e-mail containing all the 
trended data logged during the offload period. 

• Connect to the controller via modem (remote connection) or  
null modem (direct connection) and browse the available Trend 
Logs pages. 

In either case, trended data appears in textual format, which is not 
effective for data analysis. The fastest way to convert the textual 
format into a more efficient one is to import data into Microsoft Excel. 

To import trended data into Excel: 

1. Copy the logged data from its original container, e-mail message, 
or Hypertext Markup Language (HTML) page. See X368HFigure 198X and 
X369HFigure 199X. 
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Figure 198: Trend Logs on Web 

 
Figure 199: Trend Logs on E-Mail 

2. Paste the data into a standard .txt file, using Notepad or another 
text editor (X370HFigure 197X). 

 
Figure 200: Trended Data to Notepad 
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3. Save the data in a .txt file. 

4. Open the file in Microsoft Excel (X371HFigure 201X). 

 
Figure 201: Importing .txt to Excel 

5. Follow the Microsoft Excel prompts and click Finish once finished 
( X372HFigure 202X). 

 
Figure 202: Text Import Wizard 

The Excel import utility extracts the data contained in the text 
file and separates the values based on the spaces between 
columns ( X373HFigure 203X). 
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Figure 203: Microsoft Excel Imported Trend 

Note: The imported textual data may be longer than the Excel cell 
width. In this case, the data appears as in X374HFigure 200X with # characters. 
To see the actual data, you need to resize the column width. 

Adding an Image to a Web Page 
The Web Site plug-in allows you to add images to the Web pages. The 
images must be .jpg or .gif format and less than 150 KB. 

To add an image to a Web page: 

1. Right-click the Web Site root and select Image Manager  
( X375HFigure 204X). The Image Manager allows you to locate images by 
browsing your computer (376HFigure 205X). 

 
Figure 204: Importing an Image (Part 1) 
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Figure 205: Importing an Image (Part 2) 

2. Locate and select the image you want. A preview of the image 
appears along with the file details (X377HFigure 206X). 

 
Figure 206: Image Preview 

3. Click OK. The image appears in the Resources folder in the Site 
Tree (X378HFigure 207 X). 
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Figure 207: Image Imported into the Resources 

4. To add the image to a Web page, right-click the empty Web page 
and select Image and then the desired image file (379HFigure 208X). 

 
Figure 208: Add Image to a Web Page 

5. Once an image appears on the page, right-click the image to make 
it Absolute. This procedure allows you to move the image around 
the page (X380HFigure 209X). 
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Figure 209: Image Options 

Note: You can also add hyperlinks or application points on top of 
the image to create a full summarized view of the application  
( 381HFigure 210X). 

 
Figure 210: Example of Web Page with Image, Hyperlinks, and 

Application Points 

Saving the Web Site Configuration 
To save the Web Site configuration: 

• Click Exit from the File menu. The Web Site configuration 
automatically saves and compiles. 

Notification Services 
The Notification Services menu item allows you to set up the SMS, 
e-mail, and Web connection service parameters of the controller. 

Note: Notification Services are not available for every controller. 
Check the technical bulletin of the target controller to ensure these 
features are supported. 

Setting up the SMS Service Parameters 
To set up the SMS service parameters: 

1. Right-click the Application menu item and select Notification 
Services and then SMS (X382HFigure 211X). The Edit Service: SMS 
window appears (X383HFigure 212X). 
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Figure 211: Accessing the SMS Service Parameters 

 
Figure 212: Editing SMS Service Parameters 

2. Define the following information and click OK: 

• Number of Retries - defines the number of failed attempts the 
controller must reach before triggering the Communication 
Failure event related to the SMS notifications. 

• Retry Interval - defines the delay, in seconds, between two 
subsequent attempts. 

• Location - defines the string that replaces the keyword 
@LOCATION in the SMS notification message. 

• Service Center - defines the phone number the controller has 
to call to send an SMS (optional). 

Note: The modem usually uses the service center number 
defined by default on the Global System for Mobile 
Communications (GSM) Subscriber Identity Module (SIM) 
card; however, you can force the modem to contact a different 
service center number with this setting. 

• Notification Message - refers to an alphanumeric string that 
can contain tagged elements. In the string, the tags report their 
assigned value at the moment of the notification. For example, 
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the @TIME tag is replaced by the current time value. Available 
Tagged Information is as follows: 

− @LOCATION of the Controller (for example, 
@LOCATION = Meeting Room 1st Floor) 

− @NAME of the Event (for example, @NAME = Low 
Pressure Switch) 

− @DATE of the Event (for example, @DATE =  
31 Oct 2003) 

− @TIME of the Event (for example, @TIME = 12.15) 

Setting up the E-mail Service Parameters 
To set up the e-mail service parameters: 

1. Right-click the Application menu item and select Notification 
Services and then E-Mail ( 384HFigure 213). The Edit Service: E-Mail 
window appears (X385HFigure 214X). 

 
Figure 213: Accessing the E-Mail Service Parameters 

 
Figure 214: Editing E-Mail Service Parameters 
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2. Define the following information and click OK. 

• Connection Type - defines the media the controller uses to 
send e-mail notifications. 

Note: The Ethernet option is not yet implemented. Select only 
Modem. 

• Number of Retries - defines the number of failed attempts the 
controller has to reach before triggering the Communication 
Failure event related to the e-mail notifications or before 
trying the other defined Internet Service Provider (ISP) 
Access Data. 

• Retry Interval - defines the delay, in seconds, between two 
subsequent attempts. 

• Location - defines the string that replaces the keyword 
@LOCATION in the e-mail notification message. 

• Delivery Failure Address - If an e-mail message does not 
reach its destination, a Delivery Failure message is sent to the 
delivery failure address. 

• ISP Access Parameters - defines information that the 
controller uses to connect to the ISP to send e-mail notification 
messages. You can define multiple ISP Access Data as 
backups for the primary destination in case of failures. The 
controller tries to connect to the first ISP defined. If the 
connection fails for the maximum number of retries defined, 
the controller tries the second one and so on. Right-click the 
ISP Access Parameters to Add or Remove an ISP Access Data 
(element). 

• ISP Access Data: 

− Telephone - defines the ISP telephone number the 
controller calls to access a Simple Mail Transfer Protocol 
(SMTP) server to send e-mail notification messages. 

− User Identification - used by the controller to be 
authenticated from the e-mail server. 

− Password - used by the controller to be authenticated from 
the e-mail server. 

• SMTP Server - represents the name of the e-mail server the 
controller accesses to send e-mail notification messages. 

Note: This information is typically provided by the 
ISP. 

• Notification Message - is an alphanumeric string that can 
contain tagged elements. These tags report in the string the 
assigned value at the moment of the notification. For example, 
the @TIME tag is replaced by the current time value. Available 
Tagged Information is as follows: 
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@LOCATION of the Controller (for example, 
@LOCATION = Meeting Room 1st Floor) 

@NAME of the Event (for example, @NAME = Low 
Pressure Switch) 

@DATE of the Event (for example, @DATE = 31 Oct 
2007) 

@TIME of the Event (for example, @TIME = 12.15) 
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Setting up the Web Connection Service Parameters 
To set up the Web connection service parameters: 
1. On the Application menu, select Notification Services and then 

Web ( X386HFigure 215 X). The Edit Service: Web window appears  
( X387HFigure 216X). 

 
Figure 215: Accessing the Web Connection Service Parameters 

 
Figure 216: Editing the Web Service Parameters 

In configuring the Web connection service, you define the 
Authentication Couple, User Identification, and Password for each 
user that connects to the controller. Multiple users can establish a 
Point-to-Point Protocol (PPP) connection to the controller using 
the same authentication couple; however, you must make the 
connection one user at a time. 
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2. Define the following information and click OK. 

• Authentication Couple - Add authentication couples by 
right-clicking on PPP Authentication Couples and selecting 
Add Element. 

• User ID - The User ID String is limited to a maximum of 
15 characters. 

• Password - Each User ID must have its own unique password. 
Passwords are limited to a maximum of 15 characters. 

• IP Address - This parameter defines the IP address users have 
to enter into the Web browser address bar once the PPP 
connection with the controller is established. 

Hardware Parameters 
The Hardware Parameters menu item allows you to configure the 
controller hardware used for the PPP (RS-232 and modem) 
connections ( 388HFigure 217X). 

Note: Notification Services are not available for every controller. 
Check the technical bulletin of the target controller to ensure these 
features are supported. 

 
Figure 217: Hardware Parameters 
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Configuring the RS-232 Port 
When you configure the RS-232, you define the communication 
settings used by the controller during its PPP connections via  
null modem cable. This includes: 
• Baud Rate - defines the communication speed the controller 

performs during RS-232 connections. The typical value is 9600 
bits per second. 

• Flow Control - defines the type of speed control the controller 
performs on the communication to synchronize the two speeds. 
The FX controllers do not implement the software flow control 
(Xon/Xoff), so you should set this to None. 

• Stop Bits - defines the length of the stop bits present in the 
communication stream. The FX controllers use one stop bit, so 
you should set this to 1. 

• Data Bits - defines the length, in bits, of the data streams. The 
FX controllers use 8-bit data streams, so you should set this 
to 8. 

• Parity - defines the presence and the strategy to calculate the 
Parity bit (similar to a checksum). The FX controllers do not 
need any Parity bit, so you should set this to None. 

 
Figure 218: RS-232 Configuration Window 

Modem Configuration 
When you configure the modem, you define the communication 
settings, which are used by the controller during its PPP connections 
via modem, including: 
• Modem Type - defines the modem model the controller used to 

execute services. Public Switched Telecommunications 
Network (PSTN) means a landline modem and GSM is a 
modem type that uses the Global System for Mobile 
Communications (wireless). 

• Dial - defines the dial mode (pulse or tone) the controller uses 
to connect to the SMS and e-mail service providers. The dial 
mode is strictly related to the phone line that the controller 
connects to. Typically, it is set to Tone. 
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• Baud Rate - represents the communication speed the controller 
performs during modem connections. Its typical value is 
9600 Baud. 

• Ring Numbers - defines the number of rings the controller 
waits before taking an incoming call. 

• Number of Retries - defines the number of retries. 

• Auto Baud - indicates if the two modems involved in the 
communication have to automatically select the communication 
speed. Its typical value is On. 

• Init String - defines the Command Initialization String the 
controller sends to the modem at powerup. 

• Card PIN - represents the security code of the SIM card used 
by the GSM modem. You must disable the Personal 
Identification Number (PIN) on the SIM card. 

 
Figure 219: Modem Configuration Window 
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Protocol Plug-in  
The Protocol plug-in creates network profiles for the desired protocol. 
Using this plug-in, you can expose application points as N2 network 
points, as LONWORKS network variables and configuration properties, 
or as BACnet objects. 

IMPORTANT: You must create the network profile after all application 
points have been fully defined and configured. If you make application 
changes, you must update the network profile accordingly because the 
network profile does not automatically update itself. 

N2 Network Profile Plug-in 

Configuring the N2 Network Profile  
To configure the N2 Network Profile: 

1. On the Protocol menu, select Add and then N2 Open. The N2 
profile is automatically created. Every application point is exposed 
with a corresponding N2 network point (X389HFigure 220). 

2. If necessary, modify the N2 network profile as follows: 

f. Remove application points from the N2 network profile by 
clearing its On the Network box. 

g. Edit the N2 Short Name. 

h. Edit the N2 Long Name. 

i. Select a different point type (not recommended). 

j. Change the N2 Point Address (not recommended). 

3. Click Apply. 

 
Figure 220: N2 Open Plug-in Window 

Exporting the N2 Print File 
The N2 print file (.prn) contains a list of all N2 network points and 
their corresponding long name, short name, point type, point address, 
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and units of measure symbol. Use this file to assist the mapping of the 
controller’s N2 network points into an N2 supervisory class controller 
(for example, Companion or N30). 

Note: For integration into an FX40, use the .apd file. 

To export the N2 print file: 

1. From the File menu, select Generate PRN File. The Select Unit of 
Measure window appears (X390HFigure 221X). 

 
Figure 221: Selecting Desired Units of Measure 

2. Select the desired unit of measure and click OK. The Save As 
window appears. 

3. Enter the desired file name, select a location, and click Save. 

LONWORKS Network Profile Plug-in 

Configuring the LONWORKS Network Profile  
To add a LONWORKS network profile:  

1. From the Protocol menu, select Add and then LON. You can 
choose from the following methods to create the LONWORKS 
network profile: 

• Fast Map - This method automatically maps application points 
to a generic LONWORKS functional profile. 

 
Figure 222: Fast Map 

• Fixed Map - This method assists you in mapping application 
points to a specified LONWORKS functional profile. You can 
choose the desired LONWORKS functional profile from a 
predefined list in the plug-in (for example, Space Comfort 
Control profile). 
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Figure 223: Fixed Map 

2. For Fast Map configuration (X391HFigure 224X), modify the LONWORKS 
network profile as follows: 

• Remove application points from the LONWORKS network 
profile by clearing its On the Network box. 

• Edit the LON name. 

• Enable the Receive Heartbeat feature (NVI only). If you enable 
this feature, the value of the NVI reverts to invalid when the 
nciRecHrtBt time expires. If you do not enable this feature, 
the value of the NVI is retained until power cycle. 

• Change the LON index, Functional Block, and Member Index 
(not recommended). 

• Change the Program ID. 

• Change the Network Tuning Information (not yet 
implemented). 

 
Figure 224: Adding a LONWORKS Network Profile via Fast Map 

3. For Fixed Map configuration, a list of LONWORKS defined network 
variables for the selected functional profile appears. Identify which 
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application point should be mapped to the corresponding network 
variable in that list. 

Note: If the selected functional profile is not suitable, you can 
switch to the Fast Map mode. 

 
Figure 225: Adding a LONWORKS Network Profile via Fixed Map 

4. Click Apply. 

Fast Map Configuration  
If you use Fast Map configuration, the application points automatically 
map to a corresponding LONWORKS network variable. 

The LON name automatically generates based on the following rules: 

• Volatile application points of in direction receive an NVI 
prefix. 

• Volatile application points of out direction receive an NVO 
prefix. 

• All permanent application points receive a CP prefix. 

Fixed Map Configuration  
If you use Fixed Map configuration, the plug-in assists you in mapping 
an application point to a LONWORKS network variable from the 
selected standard functional profile. 
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Network Resource Files 
The LONWORKS network resource files (.xif, .typ, .fmt, .ftp, .enu) 
include detailed information (data types, enumerations, and locations) 
about the Network Variables (NVs) and CPs defined in the application 
network profile. These resource files are used by a LONWORKS 
network management tool (for example, the LonMaker® tool) to 
interpret data flowing to and from the controller. 

Resource files are grouped into resource file sets, where each set 
defines functional profiles, network variable types, configuration 
property types, enumeration types, strings, and formats for specified 
device types. File extensions include .xif, .enu, .typ, .fmt, .and .fpt. 

The range of device types a resource file set applies to is called the 
scope of the resource file set. For example, the scope may specify that 
the resource file set applies to an individual device type or to all device 
types. 

The scopes are: 

• Scope 5 - used for a user resource file set containing user resources 
for all devices with a specified Manufacturer ID and device class, 
usage, and channel. This scope value can be used by a 
manufacturer for a resource file set that applies to all of the 
manufacturer’s devices of a specific device class, usage, and 
channel type. 

• Scope 6 - Used for a user resource file set containing user 
resources for all devices with a specified Standard Program 
Identifier (SPID). This scope value can be used by a manufacturer 
for a resource file set that applies to a single device type. 

Exporting the LONWORKS Network Resource Files 
To export the LONWORKS network resource files: 

1. From the File menu, select Generate Resources Files. The Save As 
window appears. 

2. Enter the desired file name, select a location, and click OK. 
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BACnet Network Profile Plug-in 
FX Builder allows you to add BACnet object instances to the network 
profile and to map the properties of each BACnet object instance to an 
application point, which is connected to an acceptable application 
object attribute. 

You can use two methods to create the BACnet Network Profile: Fast 
Map method and Manual Map method. 

Configuring the BACnet Network Profile Using the Fast Map 
Method 
The Fast Map method creates a BACnet object for every type of 
application points. Currently, only hardware-type application points 
(for example, analog inputs, binary inputs, analog outputs, and binary 
outputs) are supported by the Fast Map method. 

To use the fast map method, select Hardware Points from the Fast Map 
menu. The BACnet Protocol window appears (X392HFigure 226X).  

 
Figure 226: BACnet Protocol Window 
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BACnet objects are automatically created for every hardware type 
application point (393HFigure 227X). Each BACnet object instance name 
property automatically maps to the name of the corresponding 
application input/output object. Each BACnet present value property 
automatically maps to the corresponding effective output value of the 
application input/output object. 

 
Figure 227: BACnet Protocol Window (with BACnet Objects) 

Configuring the BACnet Network Profile Using the Manual Map 
Method 
The Manual Map method allows you to manually add a desired 
BACnet object type to the network profile and then identify its source 
application point. 

To configure the BACnet network profile using the manual map 
method: 

1. Right-click a BACnet object type and select Add or Add Range 
( X394HFigure 228X). The Select an Object window appears (X395HFigure 229X). 

If you select Add, only one instance is created. If you select Add 
Range, multiple instances are created. 
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Figure 228: Adding a BACnet Object Instance 

 
Figure 229: Select an Object Window 

To map the BACnet object instance to a specific application 
object, click on the browse icon  next to the Present Value 
property and select the desired application object ( X396HFigure 229X). 
X397HTable 25X describes the maximum number of BACnet object 
instances supported by each FX controller type. 
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Table 25: Maximum Number of Instances 
Object Type FX06 FX07 FX14 FX16 
Analog Input 4 4 6 46 
Analog Output 4 4 4 48 
Analog Value 50 50 60 130 
Binary Input 5 5 12 68 
Binary Output 6 6 9 69 
Binary Value 10 10 10 52 
Calendar 2 2 2 2 
Device 1 1 1 1 
Event 
Enrollment 

16 16 16 40 

File 3 3 3 3 
Multistate Value 77 77 77 120 
Notification 
Class 

2 2 2 2 

Schedule 4 4 4 8 

 

2. To enable COV notification, check the COV Increment Enabled 
box and identify the COV interval (X398HFigure 230). 

 

Figure 230: Enable COV Notification 
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X399HTable 26X describes the maximum number of properties with COV 
notification supported. 

Table 26: Maximum Number of Properties with COV Notification 
Supported 
 FX06 FX07 FX14 FX16 
Maximum 
Number of 
Properties with 
COV 
Notification 
Supported 

20 20 20 50 

 

Use the following reference information to understand how BACnet 
object properties are mapped to the application objects. 
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Definition of BACnet Objects in Network Profile 
Analog Input 
You can map the BACnet Analog Input object properties to the 
application points connected to the FX Extended Analog Input 
application object attributes. 

The BACnet Analog Output object supports COV reporting on Present 
Value and Status Flag properties. 

X400HTable 27X lists the BACnet Analog Input object property information. 

Table 27: Analog Input 
Mandatory 
Property 

Optional 
Property 
Supported 

Network
Read/ 
Write  

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Default is the FX Analog Input object name. 

Edit in FX Builder. (20 char.) 
Object_Type   R BACnet standard 
Present Value  W Equal to EffectiveValue attribute of FX Analog 

Input object.  
Out_of_Service must be TRUE for write 
command. 

 Description W Edit in FX Builder. (24 characters) 
Status Flags  R IN_ALARM = Event_State 

FAULT = Reliability 
OVERRIDDEN = False 
OUT_OF_SERVICE = OOS 

Event_State  R FAULT if Reliability not equal to 
NO_FAULT_DETECTED, otherwise 
NORMAL 

 Reliability 
 

 NO_FAULT_DETECTED 
OVER_RANGE (Unreliable High) 
UNDER_RANGE (Unreliable Low) 
UNRELIABLE_OTHER 

Out_of_Service  W Write enabled only if FX Object has 
Remote_Value input. 

Units  R Default is Units of FX Analog Input Object. 
You can select SI or US units, at design time, 
in FX Builder. 

 Min_Pres_ 
Value 

R 

 Max_Pres_ 
Value 

R 

Defaults are Rel_Limit attributes of FX Analog 
Input object. 
Edit in FX Builder. 

 COV_ 
Increment 

W Default is maximum float value. 
Edit in FX Builder. 
(When COV_Increment = max value, Change 
of Value [COV] is issued only when 
Status_Flags change.) 
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BACnet Analog Input Object to FX Object Mapping 

 
Figure 231: BACnet Analog Input Object to FX Object Mapping 
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Analog Output 
You can map the BACnet Analog Output object properties to the 
application points connected to the attributes of one of the following 
FX application object types: 

• Extended Analog Output 

• Extended DAT Output 

• Extended PAT Output 

The BACnet Analog Output object supports COV reporting on Present 
Value and Status Flag properties. 

X401HTable 28X lists the BACnet Analog Output object property information. 

Table 28: Analog Output 
Mandatory 
Property 

Optional 
Property 
Supported 

Network
Read/ 
Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Default is the FX Analog Output 

object name. Edit in FX Builder. 
(20 characters) 

Object_Type   R BACnet standard 
Present_Value  W Equal to EffectiveValue or 

Position attribute of FX Object. 
Command uses Priority_Array. 

 Description W Edit in FX Builder. (24 characters) 
Status_Flags  R IN_ALARM = Event_State 

FAULT = Reliability  
OVERRIDDEN = False 
OUT_OF_SERVICE = OOS 

Event_State  R FAULT if Reliability not equal to 
NO_FAULT_DETECTED, 
otherwise NORMAL 

 Reliability R NO_FAULT_DETECTED 
UNRELIABLE_OTHER 

Out_of_Service  W Disables FX Output object. 
(Physical output does not 
change.) 

Units  R % 
 Min_Pres_ 

Value 
R Default is 0%. 

 Max_Pres_ 
Value 

R Default is 100%. 

Priority_Array  W Default is all NULL. 
Continued on next page . . . 
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Mandatory Property 
(Cont.) 

Optional 
Property 
Supported 

Network
Read/ 
Write 

Notes 

Relinquish_default  R Default is Invalid. 
(FX Object retakes control.) 

 COV_ 
Increment 

W Default is maximum float value. 
Edit in FX Builder. 
(When COV_Increment = max 
value, COV is issued only when 
Status_Flags change.) 

 

Out of Service Management 
• Out Of Service = FALSE  

Physical Channel coupled, Physical Channel value is equal to 
actual Present Value.  

• Out Of Service = TRUE  

Physical Channel decoupled, Physical Channel value is not 
influenced by Present Value. 
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BACnet Analog Output Object to FX Object Mapping 

 
Figure 232: BACnet Analog Output Object to FX Object Mapping 
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Analog Value 
You can map BACnet Analog Value object properties to the 
application points connected to the numeric attributes (input, output, 
volatile, or permanent) of an FX application object. 

The BACnet Analog Value object supports COV reporting on Present 
Value and Status Flag properties. 

X402HTable 29X lists the BACnet Analog Value object property information. 

Table 29: Analog Value 
Mandatory 
Property 

Optional 
Property 
Supported 

Network
Read/ 
Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Default is the FX Application point 

name. Edit in FX Builder. 
(20 characters) 

Object_Type  R BACnet standard 
Present_Value  W Equal to value of the FX application 

point. 
Command uses Priority_Array. 

 Description W Edit in FX Builder. (24 characters) 
Status_Flags  R IN_ALARM = Event_State 

FAULT = Reliability  
OVERRIDDEN = False 
OUT_OF_SERVICE = False 

Event_State  R FAULT if Reliability not equal to 
NO_FAULT_DETECTED, 
otherwise NORMAL 

 Reliability R NO_FAULT_DETECTED 
UNRELIABLE_OTHER 

Out_of_Service  R Always false 
Units  R Default is Units of FX application 

point. 
You can select SI or US units, at 
design time, in FX Builder. 

Priority_Array  R Default is all NULL. 
Relinquish_default  R Default is Initial Value. 
 COV_ 

Increment 
W Default is maximum float number. 

Edit in FX Builder. 
(When COV_Increment = max. 
value, COV is issued only when 
Status_Flags change.) 
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BACnet Analog Value Object to FX Object Mapping 

 
Figure 233: BACnet Analog Value Object to FX Object Mapping 

Note: An input application point (either permanent or volatile) can 
be mapped in Write mode. An output application point can be mapped 
only in read mode. 

BACnet Analog Value Object Data Type Management 

Non Structured Data Type 
You can map all the numeric data types supported by the device 
firmware to the BACnet Multistate Value object. The data types are: 

• SignedNumeric 

• UnsignedNumeric 
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Structured Data Type 

X403HTable 30X shows the fields of the Structured Data Types in the FX 
application that can be mapped to the BACnet Analog Value object. 

Table 30: Structured Data Type 
Data Type 
Name 

LONMARK Name 
 

State/Value Name 
 

Mappable to 
Analog 
Value 

Occ_Cool  
StandBy_Cool  
UnOcc_Cool  
Occ_Heat  
StandBy_Heat  

Temperature 
Setpoints 

SNVT_temp_setpt 

UnOcc_Heat  
State  
Percentage  

HVAC Override SNVT_hvac_overid 

Flow  
Function  Scene Control SNVT_scene 
Number  
Function  
Number  
Setting  
Rotation  
Fade_Time  
Delay_Time  

Scene 
Configuration 

SNVT_scene_cfg 

Scene_Priority  
Function  
Setting  

Lights and 
Sunblinds 
Setting 

SNVT_setting 

Rotation  
Current_State  
Next_State  

Time-of-Day 
Event 

SNVT_tod_event 

Time_to_Next_State  
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Binary Input 
You can map BACnet Binary Input object properties to the application 
points connected the FX Extended Digital Input application object 
attributes. 

The BACnet Binary Input object supports COV reporting on the 
Present Value and Status Flag properties. 

X404HTable 31X lists the BACnet Input object property information. 

Table 31: Binary Input 
Mandatory 
Property 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Default is the FX Digital 

Input object name. Edit in 
FX Builder. (20 
characters) 

Object_Type   R BACnet standard 
Present_Value   W Equal to EffectiveValue 

attribute of FX Digital 
Input object. 
Out_of_Service must be 
TRUE for write 
command. 

 Description W Edit in FX Builder. (24 
characters) 

Status_Flags  R IN_ALARM = 
Event_State 
FAULT = Reliability 
OVERRIDDEN = False 
OUT_OF_SERVICE = 
OOS 

Event_State  R FAULT if Reliability not 
equal to 
NO_FAULT_DETECTED
, otherwise NORMAL. 

 Reliability R NO_FAULT_DETECTED 
UNRELIABLE_OTHER 

Out_of_Service  W Write enabled only if 
FX Object has 
Remote_Value input. 

Polarity  R Default is the Digital 
Input object Polarity 
attribute. 
Edit in FX Builder. 

 InactiveText R Default is OFF. 
Edit in FX Builder. 

 ActiveText R Default is ON. 
Edit in FX Builder. 
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BACnet Binary Input Object to FX Object Mapping 

 
Figure 234: BACnet Binary Input Object to FX Object Mapping 
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Binary Output 
You can map BACnet Binary Output properties to the application 
points connected to the FX Extended On/Off Output application object 
attributes. 

The BACnet Binary Output object supports COV reporting on Present 
Value and Status Flag properties. 

X405HTable 32X lists the BACnet Binary Output object property information. 

Table 32: Binary Output 
Mandatory 
Property 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

Object_Identifier   R Set by FX Builder.  
Object_Name  R Default is the FX OnOff 

Output object name. Edit in 
FX Builder. (20 characters) 

Object_Type  R BACnet standard 
Present_Value  W Equal to LogicOutput 

attribute of FX OnOff 
Output object. 
Command uses 
Priority_Array. 

 Description W Edit in FX Builder. 
(24 characters) 

Status_Flags  R IN_ALARM = Event_State 
FAULT = Reliability 
OVERRIDDEN = False 
OUT_OF_SERVICE = 
OOS 

Event_State  R FAULT if Reliability not 
equal to 
NO_FAULT_DETECTED, 
otherwise NORMAL 

 Reliability R NO_FAULT_DETECTED 
UNRELIABLE_OTHER 

Out_of_Service  W Disables FX Output object. 
Physical output does not 
change. 

Polarity  R Default is the FX OnOff 
object Polarity attribute. 
Edit in FX Builder. 

 InactiveText R Default is OFF. 
Edit in FX Builder. 

 ActiveText R Default is ON. 
Edit in FX Builder. 

Priority_Array  R Default is all NULL. 
Relinquish_default  R Default is Invalid. 

(FX Object retakes control.) 
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Out of Service Management 
• Out Of Service = FALSE 

Physical Channel coupled, Physical Channel value is equal to 
actual Present Value. 

• Out Of Service = TRUE 

Physical Channel decoupled, Physical Channel value is not 
influenced by Present Value. 

BACnet Binary Output Object to FX Object Mapping 

 
Figure 235: BACnet Binary Output Object to FX Object Mapping 
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Binary Value 
You can map Binary Value object properties to the application points 
connected to the binary (logic) attributes (input or output, volatile, or 
permanent) of an FX application object. This includes the State field of 
an attribute based on the LONMARK variable SNVT_switch. 

The BACnet Binary Value object supports COV reporting on Present 
Value and Status Flag properties. 

X406HTable 33X lists the BACnet Binary Value object property information. 

Table 33: Binary Value 
Mandatory 
Property 

Optional 
Property 
Supported 

Network 
Read/ 
Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Default is the FX application 

point name. Edit in FX 
Builder. (20 characters) 

Object_Type   R BACnet standard 
Present_Value   W Equal to value of the FX 

application point. 
 Description W Edit in FX Builder. 

(24 characters) 
Status_Flags  R IN_ALARM = Event_State 

FAULT = Reliability  
OVERRIDDEN = False 
OUT_OF_SERVICE =False 

Event_State  R FAULT if Reliability not equal 
to NO_FAULT_DETECTED, 
otherwise NORMAL 

 Reliability R NO_FAULT_DETECTED 
UNRELIABLE_OTHER 

Out_of_Service  R Always False 
 InactiveText R Default is OFF. 

Edit in FX Builder. 
 ActiveText R Default is ON. 

Edit in FX Builder. 
Priority_Array  R Default is all NULL. 
Relinquish_default  R Default is Initial Value. 
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BACnet Binary Value Object to FX Object Mapping 

 
Figure 236: BACnet Binary Value Object to FX Object Mapping 

Note: An input application point (either permanent or volatile) can 
be mapped in write mode. An output application point can be mapped 
only in read mode. 

BACnet Binary Value Object Data Type Management 

Non Structured Data Type 
You can map the logic data type defined as Logic Control: 
UNVT_logic to the BACnet Binary Value object. 

Structured Data Type 
X407HTable 34shows the fields of the Structured Data Types in the FX 
application that can be mapped to the BACnet Binary Value object. 
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Table 34: Structured Data Type 
Data Type 
Name 

LONMARK Name 
 

State/Value Name 
 

Mappable to 
Binary Value

Value  Logic Control 
with Value 

SNVT_switch 
State  

 

Calendar 
A BACnet Calendar object is automatically mapped to the application 
points connected to the attributes of the FX Calendar application 
object. 

FX Builder automatically manages the mapping for consistency and 
synchronization with the FX application. FX Builder: 

• creates a BACnet Holiday Calendar object. FX Builder then 
maps the object to the application points connected to the FX 
Calendar object for the definition of holidays. 

• for an Alternate Schedule object, creates a BACnet Alternate 
Calendar object. FX Builder then maps the object to the 
application points connected to the FX Calendar object for the 
definition of alternate days. 

X408HTable 35X lists the BACnet Calendar object property information. 

Table 35: Calendar 
Mandatory 
Property 

Optional 
Property 
Supported 

Network 
Read/ 
Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Default is the FX Calendar 

object name. Edit in FX Builder. 
(20 characters) 
The suffix _ALT or _HOL is 
added to the name depending 
on the value of 
FX_Calendar_Type property. 

Object_Type   R BACnet standard 
 Description W Edit in FX Builder.  

(24 characters) 
Present_Value   R Value of ExceptionDate 

attribute of FX Calendar object 
DateList  W Maps to the application point 

connected to the 
ExceptionEvent attribute of the 
FX Calendar object. 

 FX_ 
Calendar_ 
Type 

R Proprietary 
DataType: UINT8: 
1: HOLIDAY  
2: ALTERNATE  
PropertyID: 9100 
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BACnet Calendar Object to FX Object Mapping 

 
Figure 237: BACnet Calendar Object to FX Object Mapping 
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Device 
A BACnet Device object defines the externally visible characteristics 
of the FX device. FX Builder automatically creates the BACnet 
Device object and maps its properties to the default initialization file 
details for the selected FX device. 

X409HTable 36X lists the BACnet Device object property information. 

Table 36: Device 
Mandatory 
Property 

Optional 
Property 
Supported 

Network
Read/ 
Write 

Notes 

Object_Identifier   R MS/TP network address in device. 
Object_Name  R Default is the FX Application 

name.  
Edit in FX Builder. (20 characters) 

Object_Type   R BACnet standard 
System_Status  R BACnet standard 
Vendor_Name  R Default is Johnson Controls. 
Vendor_Identifier  R Default is 5  

(Johnson Controls). 
Model_Name  R FX device product order code 
Firmware_Revision  R FX firmware version 
Application_ 
Software_Version 

 R Default is “”. Edit in FX Builder. 

 Location W Default is blank. Edit in FX Builder. 
 Description W Default is blank. Edit in FX Builder. 
Protocol_Version  R 1 
Protocol_Revision  R 4 
Protocol_Service_
Supported 

 R BACnet standard 

Protocol_Object_ 
Types_Supported 

 R BACnet standard 

Object_List  R BACnet standard 
Max_APDU_Length  R 480 
Segmentation_ 
Supported 

 R Only in response mode 

Max_Segments_ 
Accepted 

 R Device dependent: 
FX07, FX14: 6  
FX16: 10  

 Local_Time R 
 Local_Date R 

Maps to the Real Time Clock 
(RTC) or FX Clock and Date Set 
object. Edit in FX Builder.1 

 UTC_Offset R 
 DayLight_ 

Saving_ 
Status 

R 
Maps to the FX Clock and Date 
Set object. Edit in FX Builder.1 

Continued on next page . . . 
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Mandatory 
Property (Cont.) 

Optional 
Property 
Supported 

Network
Read/ 
Write 

Notes 

APDU_Segment_ 
Timeout 

 R BACnet default 

APDU_Timeout  R BACnet default 

Number_Of_APDU
_Retries 

 R BACnet default 

Max_Masters  W Default is 127. 
Edit in FX Builder. 

Max_Info_frames  W Default is 1. 
Edit in FX Builder. 

Device_Address_ 
Binding 

 R Empty 

Database_Revision  R 1 
Active_COV_ 
Subscriptions 

  BACnet standard 

 FXStatus  R Proprietary 
0: Idle 
1: Busy 
2: Initialization 
3: Working 
4: Test 
5: Error 
6: Stopping 
DataType: UINT8 
PropertyID: 9007 

 Charset  W Proprietary 
ANSI X3.4 or ISO10646 UCS2 
Default is ANSI X3.4 
DataType: UINT8 
PropertyID: 9005 
Edit in FX Builder. 

 FamilyID R Proprietary 
DataType: UINT16 
PropertyID: 9000 

 CustomerI
D 

R Proprietary 
DataType: UINT16 
PropertyID: 9001 

 Application
ID 

R Proprietary 
DataType: UINT32 
PropertyID: 9002 

Continued on next page . . . 
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Mandatory 
Property (Cont.) 

Network 
Read/ 
Write 

 Notes 

 Unique 
Device 
Identifier 

R Proprietary 
DataType: Bytestring[6] 
PropertyID: 9003 

 FX 
Supported 
Services 

R Proprietary 
DataType: BitField[2 bytes] 
PropertyID: 9006 

3. All FX Controller Platform devices support the service DM_TS_B. 

• Local_Time and Local_Date are always supported. 
• Local_Time and Local_Date are set to the time parameter in DM_TS_B 

service. 
If the application includes the Clock and Date Set object, the FX devices also 
support the service DM_UTC_B. 
• DST_Status and UTC offset are then also supported. 
• When receiving DM_UTC_B, Local_Time, Local_Date and DST_Status are set 

with reference to UTC time parameter in DM_UTC_B and UTC offset. 
• When receiving DM_TS_B, Local_Time and Local_Date are set to the time 

parameter of DM_TS_B service and DST_Status is recalculated. UTC offset is 
not used. 

 

BACnet Device Object to FX Object Mapping 

 
Figure 238: BACnet Device Object to FX Object Mapping 
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Event Enrollment 
The BACnet Event Enrollment object type contains the information 
required for managing events within the BACnet system. The primary 
purpose for the Event Enrollment object is to define an event and to 
provide a connection between the occurrence of the event and the 
transmission of a notification message to one or more recipients. 

FX Builder creates the following: 

• the required BACnet Multistate Value objects for event 
reporting, linking them to the application points defined as 
events in the FX application for notification to a UI device. 

• the Event Enrollment objects for the events defined in the 
FX application, referencing both the Multistate Value objects 
and the Notification Class objects which have been created. 

Note: Event Enrollment objects are only created for the application 
points defined as events for a user interface in the application and 
mapped using Multistate Value objects. This feature maintains the 
synchronization of events reported at a local user interface and 
reported over the BACnet network. You cannot create or delete Event 
Enrollment objects. 

X410HTable 37X lists the BACnet Event Enrollment object property 
information. 

Table 37: Event Enrollment 
Mandatory 
Property 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Event name. Edit in FX 

Builder. (20 characters) 
Object_Type   R BACnet standard 
 Description W Edit in FX Builder. 

(24 characters) 
Event_Type  R CHANGE_OF_STATE 
Notify_Type  R EVENT 

ALARM 
Default is EVENT. 
Edit in FX Builder. 

Event_Parameters  R TimeDelay = 1s 
List_Of_Values  
(for OFFNORMAL) 
Defined in FX Builder Event 
window. 

Continued on next page . . . 
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Mandatory 
Property (Cont.) 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

Object_Property_ 
Reference 

 R Reference to the Multistate 
Value object mapped to the 
FX application point 
generating the event. 

Event_State  R NORMAL 
OFFNORMAL 

Event_Enable  R Default = TO OFFNORMAL 
Edit in FX Builder. 

Acked_Transitions  R BACnet standard 
Notification_Class  R NC_AckRequired 

NC_AckNotRequired 
(Acknowledgement defined 
in FX Builder Event 
window.) 

Event_Time_Stamp  R BACnet standard 

 

BACnet Event Enrollment Object to FX Events/Application 
Points Mapping 

 
Figure 239: BACnet Event Enrollment Object to FX Object Mapping 
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File 
The BACnet File object describes properties of data files that are 
accessed using File Services. The files manage the proprietary 
information required by the FX devices. This includes both application 
software and firmware file management. 

FX Builder automatically creates the following: 

• an application file (executable code) 

• a zipped application file (with full graphic user interface data) 

The firmware file is loaded into the device at the factory. 
FX controllers support the FX files described in X411HTable 38X. 

Table 38: File Descriptions 
File Name Type Description 
Reserved_1 0x0 Reserved for future use 
Firmware 0x1 Firmware of FX device 
Application 0x2 Application code for FX 

device 
Zipped Application 0x3 Complete user interface and 

all other information needed 
to download, upload, and 
synchronize the application 
data. 

Reserved_2 0x4 to 0xFF Reserved for future use 
Reserved_3 0x100 to 0xFFFF Reserved for future use 

 

X412HTable 39X lists the BACnet File object property information. 

Table 39: File 
Mandatory 
Property 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Set by FX Builder. 
Object_Type  R BACnet standard 
File_Type  R This is a string value 

representing a Hex 
number in the range 
0x0 to 0xFFFFFF. 
See X413HTable 38X. 

File_Size  W File size in bytes 

Modification_Date  R Date of file creation 
Archive  W Default to TRUE 
Read_Only  R TRUE 
File_Access_Method  R STREAM_ACCESS 
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Multistate Value 
You can map A BACnet Multistate Value to the application point 
connected to an enumerated attribute (input or output, volatile, or 
permanent) of an FX application object. 

The BACnet Multistate Value object supports COV reporting on 
Present Value and Status Flag properties. 

X414HTable 40X lists the BACnet Multistate object property information. 

Table 40: Multistate Value 
Mandatory 
Property 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Default is the FX 

application point name. 
Edit in FX Builder. 
(20 characters) 

Object_Type   R BACnet standard 
Present_Value   W Equal to value of the FX 

application point. 
 Description W Edit in FX Builder. 

(24 characters) 
Status_Flags  R IN_ALARM = 

Event_State 
FAULT = Reliability  
OVERRIDDEN = False 
OUT_OF_SERVICE 
=False 

 Reliability R NO_FAULT_DETECTED 
UNRELIABLE_OTHER 

Event_State  R NO_FAULT_DETECTED 
UNRELIABLE_OTHER 

Out of Service  R Always false 
Number_Of_States  R Default is the number of 

states in enumerated 
data type of FX 
application point 

 StateText R Default is the names of 
the states in enumerated 
data type of FX 
application point. 
Edit in FX Builder. 

Priority_Array  R Default is all NULL. 
Relinquish_default  R Default is Initial Value. 
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BACnet Multistate Value Object to FX Object Mapping 

 
Figure 240: BACnet Multistate Value Object to FX Object Mapping 

Note: You can map an input application point (either permanent or 
volatile) in write mode; however, you only map an output application 
point in read mode. 
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BACnet Multistate Value Object Data Type Management 

Non-Structured Data Type 
You can map all the enumerated data types supported by the device 
firmware to the BACnet Multistate Value object. 

Structured Data Type 
X415HTable 41X shows the fields of the Structured Data Types in the 
FX application that can be mapped to the BACnet Multistate Value 
object. 

Table 41: Structured Data Type 
Data Type 
Name 

LONMARK Name 
 

State/Value Name 
 

Mappable to 
Multistate 
Value 

State 
Percentage 

HVAC Override SNVT_hvac_overid 

Flow 

 

Function Scene Control SNVT_scene 
Number 

 

Function  
Number  
Setting  
Rotation  
Fade_Time  
Delay_Time  

Scene 
Configuration 

SNVT_scene_cfg 

Scene_Priority  
Function  
Setting  

Lights and 
Sunblind 
Setting 

SNVT_setting 

Rotation  
Function  
Setting  

Lights and 
Sunblind 
Setting 

SNVT_setting 

Rotation  
Current_State  
Next_State  

Time-of-Day 
Event 

SNVT_tod_event 

Time_to_Next_State  
Pilot  State  
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Notification Class 
The BACnet Notification Class object represents and contains 
information required to distribute event notification within BACnet 
systems. Use notification classes to event-initiate objects with identical 
needs in terms of how their notification is handled, the desired 
notification destinations, and the preferred way to acknowledge the 
notification. 

FX Builder: 

• detects if events are defined in the application. FX Builder the 
creates one Notification Class object to manage the events that 
requires acknowledgement and another Notification Class 
object to manage the events that do not require 
acknowledgement. 

• sets up the default attributes of the Notification Class objects 

Note: You cannot create or delete Notification Class objects. 

X416HTable 42X lists the BACnet Notification Class object property 
information. 

Table 42: Notification Class (NC) 
Mandatory 
Property 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

Object_Identifier   R Set by FX Builder. 
Object_Name  R Defaults are: 

1 = NC_AckRequired 
2 = NC_AckNotRequired 

Object_Type   R BACnet standard 
 Description W Edit in FX Builder. 
Notification_Class  R BACnet standard 
Priority  W Default is: 128,128,128 

Edit in FX Builder. 
Ack_Required  R Default is:  

1 = 1,0,0 for object with 
Ack 
2 = 0,0,0 for object without 
Ack 

Recipient_List  W BACnet standard 



 FX Tools Software Package - FX Builder User’s Guide 

 

206 

Schedule 
The BACnet Schedule object properties map to the application points 
connected to the attributes of an FX On-Off or Weekly Occupancy 
Schedule application object. 

FX Builder automatically manages the mapping for consistency and 
synchronization with the FX application. FX Builder: 

• creates a normal BACnet Schedule object and maps the 
Weekly_Schedule property to the application point connected to 
the Event input attribute of the FX On-Off or Weekly 
Occupancy Schedule application object. 

• if the ExceptionDay input connects to the FX On-Off or Weekly 
Occupancy Schedule application object, maps the 
Exception_Schedule property of the normal Schedule object to 
the application point connected to the Event input attribute of 
the On-Off or Weekly Schedule application object. This is for 
the definition of holiday events. 

• if the AlternateEvent and the ExceptionDay inputs connect to 
the FX On-Off or Weekly Occupancy Schedule application 
object, creates an alternate Schedule object and maps the 
Weekly_Schedule property to the application point connected to 
the AlternateEvent input attribute. This is for the definition of 
alternate events. The Exception_Schedule property is not used. 

Table 43: Schedule 
Mandatory Property Optional 

Property 
Supported 

Network 
Read/Write 

Notes 

Object_Identifier   R Set by FX Builder  
Object_Name  R Default is the Schedule 

object name. Edit in FX 
Builder. (20 characters) 

Object_Type   R BACnet standard 
Present_Value  R On-Off Schedule: 

Equal to value of Output 
attribute of On-Off 
Schedule object. 
Weekly Occupancy 
Schedule: 
Equal to value of 
Output.Current_state 
field of Output attribute of 
Weekly Occupancy 
Schedule object. 

 Description W Edit in FX Builder. 
(24 characters) 

Continued on next page . . . 
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Mandatory 
Property (Cont.) 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

Effective_Period  R 1st January to  
31st December of any 
year 

Weekly_Schedule  W Schedule (Normal): 
maps to the application 
point connected to the 
Event input attribute of 
an On-Off or Weekly 
Occupancy Schedule 
object. 
Schedule (Alternate) - 
optional: maps to the 
application point 
connected to the 
AlternateEvent input 
attribute of an On-Off or 
Weekly Occupancy 
Schedule object. 

Exception_Schedule  R Schedule (Normal): 
maps to the holiday 
(exception) events of the 
application point with an 
event data type and 
connected to the Event 
input attribute of the On-
Off or Weekly 
Occupancy Schedule 
object. 
Schedule (Alternate) - 
optional: not used. 

Schedule_Default  R Off  
List_Of_Obj_Property
_Ref 

 R On-Off or Weekly 
Occupancy Schedule 
Output (Fixed)  

Priority_for_Writing  W Default is 16. 
(Not used in FX 
application) 

Status_Flag  R IN_ALARM: Always false 
FAULT: Always false 
OVERRIDDEN: Always 
false 
OUT_OF_SERVICE: 

Out_Of_Service status 
Reliability  R Always False 
Out_Of_Service  R Schedule (Normal):  

TRUE when day is 
Alternate 
FALSE when day is 
Normal 
Schedule (Alternate): 
TRUE when day is 
Normal 
FALSE when day is 
Alternate 

Continued on next page . . . 
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Mandatory 
Property (Cont.) 

Optional 
Property 
Supported 

Network 
Read/Write 

Notes 

 Schedule_ 
FX_Out 

R Proprietary 
Maps to the FX On-Off or 
FX Weekly Occupancy 
Schedule - 
Output.Current_State. 
DataType: UINT8: 
PropertyID: 9101 

 Type R Proprietary 
DataType: UINT8 
0 = On-Off Schedule 
(Default) 
1 = WeeklyOccupancy 
Schedule 
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BACnet Schedule Object to FX On-Off Schedule Object 
Mapping 

 

 
Figure 241: BACnet Schedule Object to FX On-Off Schedule Object Mapping 
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BACnet Schedule Object to FX Weekly Occupancy Schedule 
Object Mapping 

 

 
Figure 242: BACnet Schedule Object to FX Weekly Occupancy Schedule Object Mapping 
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FX Builder Security 
FX Builder and the FX controllers use an embedded security feature 
based on the use of identifiers: the Family ID and the Customer ID. 

Family ID 
The Family ID is used to distinguish between different hardware types 
and to avoid downloading an application to the wrong controller. 

Table 44: Family IDs 
Facility Explorer Controller FX Builder 

Code 
Family ID 

FX05P11-02 0218 

FX05P11-12 0210 
FX05P11-22 0211 

FX05P12-02 0212 

FX05P12-12 0214 

FX05P12-22 0215 

FX05P13-02 0213 

FX05P13-12 0216 

FX05 (Advanced) Controller 

FX05P13-22 0217 

FX06 Compact Controller (Models FX06P0x, 
FX06P2x, and FX06P3x) Original and Rev. A 

FX06P0x 0701 

FX06 Compact Controller (Models FX06Px4, 
Rev. B (BACnet) 

FX06Pnn Rev. B 0705 

FX06 Compact Controller (Models FX06P1x) 
Original and Rev. A 

FX06P1x 0700 

FX07 Field Controller (Models FX07Dxx and 
FX07Axx) Original 

FX07D0x 0900 

FX07 Field Controller (Models FX07Dx4 and 
FX07Ax4) Rev. A (BACnet) 

FX07Dnn Rev. A 0904 

FX14 Field Controller (Models FX14Dxx) 
Original and Rev. A 

FX14D1x 0801 

FX14 Field Controller (Models FX14Dx4) 
Rev. B (BACnet) 

FX14Dnn Rev. B 0804 

FX15 Field Controller (Models FX15D1x, 
FX15D2x, FX15D6x, FX15D7x, FX15X1x, 
FX15X2x, FX15X6x, FX15X7x) Original and 
Rev. A 

FX15D1x 0402 

FX15 Universal Controller (All models 
FX15D0x, FX15D5x) Original and Rev. A 

FX15D0x 0401 

Continued on next page . . . 
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Facility Explorer Controller (Cont.) FX Builder Code Family ID 
FX16 Master Controller (All Models FX16Dxx 
and FX16Xxx) Original and Rev. A 

FX16D0x 0501 

FX16 Master Controller (All Models FX16Xx4) 
Rev. B (BACnet) 

FX16Xnn Rev. B 0504 

MD20D00 0600 

MD20D01 0601 

MD20D02 0602 

MD20D03 0603 

MD20D04 0604 

Master Display 

MD20D05 0605 

 

Customer ID 
Customer ID is used to distinguish between the: 

• generic user (MAKE PUBLIC ID) 

• Demo ID 

• Customer/Private Specific ID 

The Customer ID protects the controller downloaded with a 
custom-developed application. The Customer ID also protects the 
application source code from being edited by unauthorized users. 

The Make Public ID allows you to: 

• Read all public application source files (saved with the very same 
Public ID). 

• Download these applications to standard Facility Explorer 
controllers, which remain downloadable from whoever has the 
same Public ID. 

The Demo ID allows you to: 

• Read demo applications only (for example, applications that have 
been saved with the Demo ID). 

• Download the demo applications to demo cases or demo 
controllers. 

The Customer/Private Specific ID allows you to: 
• Make the application source files readable only by users who have 

the same Specific ID installed on their computer. 
• Download the applications to standard Facility Explorer 

controllers, which then become customer specific and 
downloadable only with applications saved with the same 
customer specific ID. To receive a Customer Specific ID, 
contact your local Johnson Controls® representative. 
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Checking Application Point Limits 
Each FX controller has its own unique memory and application point 
limitations. FX Builder compares the application memory and 
application point usage to the device memory and application point 
usage. 

To check application point limits: 

1. From the Application menu, select Check Consistency. The Export 
Statistics & Check window appears (X417HFigure 243X). This window 
contains two tabs: 

• Memory Usage - identifies the used and available memory and 
the distribution of the used memory (X418HFigure 243X). 

 
Figure 243: Export Statistics and Check Memory Tab 

• General Info - identifies the current application point usage, 
the maximum limits of the target device, and any missing 
mandatory connections (419HFigure 244X). 
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Figure 244: Export Statistics and Check General Info Tab 

Exceeding the limits or missing mandatory connections results 
in error during the Save operation. FX Builder automatically 
opens the Export Statistics and Check window, reports the 
error location, and allows only the Save without Export action 
( 420HFigure 245X). 
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Figure 245: Error Reported When Missing Mandatory Connections 

Checking Mandatory Inputs 
You can view more detailed information on missing mandatory 
connections if you check for mandatory inputs. 

To check mandatory inputs: 

• On the Application menu, click Check Mandatory Inputs. The 
Missing Mandatory Connections window appears. 

 
Figure 246: Missing Mandatory Connections Window 
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Compiling and Saving Applications 
To compile and save your application: 

1. On the File menu, click Save or Save As. 

2. If you selected Save As, enter the new file name and location for 
the application. 

During the Save operation, FX Builder exports the application file 
with an .apd file extension. This file contains the complete 
application, including the control algorithm, application point 
definitions, event and trend configurations, Web site, display 
configuration, and network profile. 

Note: An application file can contain only one network profile 
(N2 Open, LON, or BACnet). 
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Specifications and Technical Data 
Ordering Codes 
Table 45: Software 
Product Code Product Description 
LP-FXTPRO-0 FX Tools Pro CD ROM (FX Builder, FX CommPro N2, FX CommPro LON, FX 

CommPro BACnet, FX Loader, and MD LON Loader) – New User 
LP-FXTPRO-6 FX Tools Pro CD ROM (FX Builder, FX CommPro N2, FX CommPro LON, FX 

CommPro BACnet, FX Loader, and MD LON Loader) – Upgrade 

 

Technical Specifications 
Table 46: FX Builder 
Product Code Product Description 
Operating System Microsoft Windows 2000 (with Service Pack 4 or later) 

Microsoft Windows XP® (with Service Pack 1 or later) 
Processor Intel® Pentium® Processor, 500 MHz or higher 
RAM Minimum 512 MB RAM (1 GB recommended) 
Hard Disk 60 MB for storage of FX Tools  

2.5 MB (typical) to 6 MB (maximum) for storage of each application file 

Hardware 
Requirements 

Display Display resolution 800 x 600 16-bit (32,768) color minimum 
Software Requirements Microsoft Internet Explorer® Version 5.0 or later 

Microsoft .NET Framework Version 2.0 

The performance specifications are nominal and conform to acceptable industry standards. For application at conditions 
beyond these specifications, consult the local Johnson Controls office. Johnson Controls, Inc. shall not be liable for damages 
resulting from misapplication or misuse of its products. 

 
 

Building Efficiency 
507 E. Michigan Street, Milwaukee, WI  53202 

 
 Johnson Controls® is a registered trademark of Johnson Controls, Inc. 

All other marks herein are the marks of their respective owners. © 2009 Johnson Controls, Inc. 
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